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About the speaker

Lovekesh Kakkar

Lovekesh Kakkar is a Designated Support Specialist at Autodesk where he
specializes in Civil 3D, InfraWorks and ReCap products. As a member of the
Autodesk Enterprise Priority Support team, he supports global enterprise
customers with proactive support services to help increase efficiency, reduce
risk, and avoid issues before they occur. Prior to joining Autodesk, Lovekesh
gained over 10 years experience in the civil infrastructure & GIS industry,
working as a GIS Engineer for large consulting companies and Application
Engineer/ BDM Techno-Sales for an Autodesk Platinum Partner & Autodesk
Distributor. Lovekesh experience extends from GIS service industry to
Technical sales & Business development work with a variety of software
packages. He is an AutoCAD Civil 3D Certified Professional, ATC Certified
Instructor and has previously spoken at Autodesk University-Kenya.



Safe harbor statement

During the course of this presentation, we may make statements regarding future
events and/or statements regarding planned or future development efforts for our
existing or new products and services. We wish to caution you that such
statements reflect our current expectations, estimates and assumptions based on
factors currently known to us and that actual events or results could differ
materially. Also, these statements are not intended to be a promise or guarantee
of future delivery of products, services or features but merely reflect our current
plans, which may change. Purchasing decisions should not be made based upon
relilance on these statements. The statements made in this presentation are being
made as of the time and date of its live presentation. We do not assume any
obligation to update any statements we make to reflect events that occur or
circumstances that exist after the date of this presentation.



Streamline data sharing Civil 3D, Revit & InfraWorks

What you’ll learn today

Coordinate System ?

Coordinate System: What? Why?
How?
Understand Coordinate System

for Products

Collaborate with Civil 3D Collaborate with Revit

* Infraworks to Civil 3D « Workflows: Assign, Acquire,

 Revitto Civil 3D Publish Coordinates to Revit
* Prepare your Revit Model for

exporting out

Collaborate with
Infraworks

Workflows: Revit, FBX, IFC &
Civil 3D to Infraworks
Prepare your Infraworks Model

for exporting out



Coordinate System?

Coordinate System: What”? Why? How?



Why we need a coordinate system?

Non circular/ellipsoidal undulated shape of Earth needs coordinate system !!

Actual Earth
A very Lumpy object that has
topography, bathymetry,

Changing ocean height, etc..

There are many ellipsoids you can use to reference locations of
the earth with latitude and longitude, these different geographic
coordinate systems are called datums. Certain datums fit different
parts of the lumpy earth better than others, so changing datums
can make measurements more accurate depending on where
you are

For nearly all basic mapping, however, there are three datums
that are all you need to know; WGS84, NAD 83 and ITRFOO

GIS Coordina’te System (lat, long)

In geodesy, a reference ellipsoid is a
mathematically defined surface that
approximates the geoid, the truer
figure of the Earth
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Projected Coordinate System (it, km)
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Geoid

Planner (cartesian) coordinates are
the way of assigning a set of
Coordinates to locations

A less lumpy mathematical
approximation of the earth

Projections:

The world is a three dimensional (3D) ellipsoid but almost all the media [/
we work with is 2 dimensional (2D) and In order to transform these gl
latitude and longitude (spherical) coordinates into meaningful units, the
datum must be transferred to a planar (cartesian) coordinate system.
There are many ways to do this, and these are called projections

There are three ways to transfer the curved surface of the ellipsoid to a

flat plane, you can make Cylindrical, Conic or Planar (azimuthal),
i | >
In order to make different measurements-distance, area, shape, or e il
oy
N/ Map Projection Families

projections
' ord ts-d . (0
direction-you must choose the best projection for the job g



Why W(GS84 is the most common Datum 7

WGS84: WGS84 ellipsoid origin center of earth

The origins of the WGS84 and NADSS3 ellipsoids are at the center of the earth’s mass, which
makes them ideal for a GPS datum

Global datum Local datum

® Center of ellipsoid

o Center of mass of earth


https://confluence.qps.nl/qinsy/en/world-geodetic-system-1984-wgs84-29855173.html

Latitude and Longitude

Spherical coordinate system of the globe can be expressed as Latitude & Longitude

= Latitude lines run east-west and are parallel to
each other. If you go further north, latitude values
increase. Finally, latitude values (Y-values) range
between -90 and +90 degrees

= Longitude lines run north-south. They converge at/ "
the poles. And its X-coordinates are between -130 ,"' _.

and +180 degrees @ (’§ ' .
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Why we need Projected coordinate system

The Coordinate system that is used to draw the earth on a flat map

= GIS Coordinate System : LL384

= Reference/Datum : WGS84 (World Geodetic System of 1984,
Spheroid)

= Ellipsoid : WGS84 (World Geodetic System of 1984, GEM 10C)
= Measurement Unit : Degree
= Representation : Latitude-Longitude
* Projected Coordinate System : UTM84-43N

= Projection : Universal Transverse Mercator System

= Reference/Datum : WGS84 (World Geodetic System of 1984,
Spheroid)

= Ellipsoid : WGS84 (World Geodetic System of 1984, GEM 10C)
= Measurement Unit : Meter
= Representation : Latitude-Longitude



UTM Grid Zones of the World

Global view of UTM grids (notice — Distortion minimized in a N-S “Strip” ZONE)
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UTM Grid Zones of the World

How to find in which UTM projected coordinate system grid your site situated in?

File Edit View Tools Add Help

¥ Search

Get Directions History

¥ Places

v /& My Places
» ¥ 3 Sightseeing Tour

v ¥ &3 Mount Abu
v/ & MAlshp

v.Vv.v.v.v.v
L NRA TA L SR N

MAB.shp
v Untitled Placemark
- Temporary Places

o [0 'l

¥ Lavers
v B3 Primary Database
B Announcements
» 'F Borders and Labels "= Google Earth Options
Ll Places
4 = Photos 3DView | Cache Touring  Navigation  General
E= Roads _ o _ ,
b v @ 3D Buildings Texture Colors Anisotropic Filtering Labels/Icon Size Graphics Mode
g &# Ocean High Color (16 bit) Off Small OpenGL
> LI 3¥ Weather ®) True Color (32 bit) ® Medium ® Medium ® DirectX
» W Gallery
> @ Global Awareness v Compress High Large Use safe mode
4 [7 More )
Y Terrain Show Lat/Long Units of Measurement

Decimal Degrees

Degrees, Minutes, Seconds System default

Degrees, Decimal Minutes Feet, Miles Choose 3D Font o GOO g Ie E a rt h
® ' Universal Transverse Mercator @ Meters. Kilometers :
Military Grid Reference System

Imagery Date: 12/14/2015 43 P 422281.54 m E 1202834.42 m N eye alt 13886.85 km



UTM Grid Zones of the World

Site view from Lat long & UTM perspective

ImageiLandsat  Copernicus
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43 Q 661909.25 m E 2085797.84 m N elev 551 m  eye alt 3481.86 km



Coordinate System?

Understand Coordinate System by Products



Why it is Important to Understand the Difference

Linear & Vertical project has different requirement

VERTICAL
How i1t Is located and built on Earth

= Length, area, and height of project

= Elevation on earth

= | ocation and orientation

Design constraints
= Shape of Earth vs. flat design plane HORIZONTAL
= | ocal vs. assumed coordinate systems

= Double vs. single precision applications

= QOrthogonal vs. meandering




Important to Understand the Difference in Applications

Linear & Vertical project has different requirement _
VERTICAL = Revit R

Design Authoring Applications

= Revit — Vertical Projects

= Civil 3D — Horizontal Projects

= |nfraworks - Both

Design Review and Federation Applications ' HORIZONTAL = Civil 3D A

» Navisworks Manage for clash functions

= |nfraworks

* Visualization




Being geospatially aware as your proauct may not be!

All because of precisions

Geospatial coordinate values are long & not all Autodesk products are geospatially aware:

ilnsgtl)es-pl\sleacilsmn Single Precision Numbers - 9 Significant Digits

X| Revit 123456789 12,345.6789 12,345,678.9

Xl Inventor t 1 T

Double-precision

AutoCAD

Civil 3D

InfraWorks - N -

ReCap Double Precision Numbers - 15 Significant Digits
Navisworks 123456789876543 1,234,567,898.76543 12,345,678,987,654.3

t .+ 1



Degradation of Data

All because of precisions

= There are pitfalls associated with [
the exchange of data between [
single and double precision
coordinate system, specifically
the degradation of your dataset

= This example occurs when direct i
import of a double precision
dataset into a single precision
product

= This demonstrates very
succinctly what can happen to
your data if not translated in a
double precision environment
first




Streamline data sharing Civil 3D, Revit & InfraWorks

What you’ll learn today

Coordinate System ?

» Coordinate System: What? Why?
How?
* Understand Coordinate System

for Products

Collaborate with Civil 3D

 |Infraworks to Civil 3D
 Revitto Civil 3D

Collaborate with Revit

« Workflows: Assign, Acquire,
Publish Coordinates to Revit
Prepare your Revit Model for

exporting out

Collaborate with
Infraworks

 Workflows: Revit, FBX, IFC &
Civil 3D to Infraworks
* Prepare your Infraworks Model

for exporting out



Collaborate with Civil 3D

Workflows: Infraworks to Civil 3D



Workflow - Import data from Infraworks to Civil 3D
When importing IMX/*.Sqlite, set Coordinate system first!

For a visual verification of the
Coordinate System...

X
"= |n TOOISpaCG, select the | To bring model objects in successfully, you must set an appropriate
setti ngS tab and rlg ht click the EREE ~ coordinate system. How would you like to do this?
I TOOL;PACE The coordinate system you set should be within the extents of the InfraWorks 360 model ;
DWG name " Se I eCt ed It and use the same units of measure as the drawing. 7/
drawing settings T — e
Ty e .—> Use the InfraWorks 360 model coordinate system .
_ £ uroc  [UTM84-56S] | e
- I N th e U n ItS a nd ZO ne ta b Of 4:2?;319 Use this option if the InfraWorks 360 model coordinate system is appropnate for 1:1000
! o o - = Alignment the drawing. Note that Civil 3D does not support coordinate systems that are based §| | custom scale:
the DraWI ng Settl ngS d IalOg 9y :Z::Z View on latitude-longitude coordinates. [ [(000

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

@ Superelevation View

box, you will need to make

#63 Sample Line —> Select a coordinate system for the drawing

sure th e corre Ct COO rd | N ate +i§:§:2: View Use.this option if you have a strong understanding of coordinate systems in your
. f f’j Mass Haul Li.ne project area.
System is set up i
T o g ot — Use coordinate system [UTM84-56S]
) :;5"“““'9 The InfraWorks 360 model is within this coordinate system, but selecting a more
Il Late I a p p I y same COO rd N ate : : EEZZE: :::Iork specific coordinate system for the drawing is recommended.
+¥ Fitting

System when importing AIW* | e S
Model o — , " e




Workflow - Import data from Infraworks to Civil 3D
Export project boundary as *.shp/*.sdf (Optional)

*Open "Project Boundary.dwg” & use
command: "mapexport” to export the
project boundary as shp/sdf format

"\Window>Section>Pick polyline from the
window and select the geometry by
selection or layer

"\Window>Data>Select Attribute (If any)

=\Window>QOptions>check the “Treat closed
polyline as polygons” so that this geometry
will be treated as polygon not polyline,
Click OK

*Area must be less than 200sgkm

= 1
..............
=0 X
A Ex Locati X ‘
HIRA - @_‘ m
A Export - C:\Users\..\Project_Boundary.shp
Selection | Data | Options
o= [mk 32
A Export - C:\Users\..\Project_Boundary.shp
eeeeeeeee | Options
= 003X

uuuuuuuu

Selection| Data Options

CCCCC




Workflow - Import data from Infraworks to Civil 3D

Use model Builder to create Infraworks model

I Autodesk InfraWorks X

=Open Model Builder & Click on “Import a ‘
polygon to select an AOI" >Select the S o

"Project_Boundary *.shp & *.Prj” (Or Type | v«
“Mount Abu™>Search)

*Make sure the area of project boundary is
less than 200sq. km

*Give model name “Mount_Abu_Project” &
click>create Model

*Once the model is downloaded you will
receive an email notification

*Choose: Where would you like to store this
model”? BIM 360 or local drive

‘9900 -

IX72579 S6AN 24852222 A¥ZF2 BIFAN 46 51 m}




Workflow - Import data from Infraworks to Civil 3D
Import AIW Model in to Civil 3D

[ | [ ] [ | ’g | N E’I L= o ‘E‘ - - - % Civil 3D Autodesk Civil 3D 2020 Project_Boundry.dwg » Type a keyword or phrase " Lovekesh.Kakk...”
a <~ Points & Parcel "> Alignment 8 Intersection ~ j‘ Profile View j J +.T S V.T J .T T f‘ J f] +AT 4 Move C Rotate % Trim ~ /
L J ey o . — e
& Surface *J Feature Line | Profile Assembly "- —D Sample Line = A J ~ I A [\J = il +h P.T 2N DS Copy A\ Mirror [ Fillet -~ &5
| | ] | “ | ,, - - — ) Insert Pl Delete Pl _ Elevation Insert Elevation Delete Elevation _ -
In In Al Survey Query & Grading W Corridor JiPi @, Section View w Editor Point Point % U D—; Stretch []Scale 88 Aray - &
I S a p p I e I rOJ e C O u a ryl Wg ’& | "W El = 'E' - - y Q(’lwl 3D vs Autodesk Civil 3D 2020 Project_Boundry.dwg » Type a keyword or phrase M Lovekesh.Kakk...”

Modify

Geolocation o -

lg & E{ = d « - - ¥ Civil 3D Autodesk Civil 3D 2020 Project_Boundry.dwg Type a keyword or phrase "N Lovekesh.Kakk...~

= Close Infraworks software & open P B mmB B
Infraworks model from Civil 3D T o o v o moewm s L
“Infraworks Tab”™ and browse your model ‘

from “Documents\Autodesk InfraWorks ‘

InfraWorks aborate [ id-ins eatured Apy st Vehicle Tracking | Geolocation -

9 BT : Sy o S (‘\b‘\q,._w“s A |
Models\Autodesk 360\xxxxx” path AR

= |Import the "Extents of InfraWorks model”
or “Area Of Interest”

= Create/Configure the layers and other gy A

Name AIW_Existing_Ground

n ecessa ry Setti ngS frO m th e “O bj eCt ) 1 " )f : A 5 ,» A ‘ ) Style Eilgitgﬂm and 5m (Background)

Settlngsu & “O Ku > quen MOdelu et e 3 s oo

Mungthala C

= You may import using IMX format ' |



Collaborate with Civil 3D

Workflows: Revit to Civil 3D



Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

ile>Export>CAD Formats>DWG

reate a new Set to add the views,
hich you want to export

heck all or desire views to export as
rawings

nd to Modify Export Setup, Click >
xportSetup, | - |(Disabled entities from
isibility Graphics won't appear here

ou can also choose desire options from
tabs like Layers, Lines, Color, etc

A @B~ — . - == 0 o = Autodesk Revit 2020 - CWO02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site < v -
= ") ) v G = % Lovekesh.Kakk... - & X
Architecture ~ Structure  Steel ~ Systems Insert Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools ~ Modify o -
= A~~~ & - SO - O 2 0. 5 Autodesk Revit 2020 - CW02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site < v -
=4 T ) v G 2 i == | "z {8 pare y g porting Lovekesh.Kakk... - & X
Architecture  Structure  Steel  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate ~ View  Manage  Add-Ins  Quantification  Site Designer  BIM Interoperability Tools  Modify o -
= @B-R~-~> -2 0 2- O S| [ 5 Autodesk Revit 2020 - CWO2 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site < v =
= T ) v 0 - [ ] == | "z {3 9 9 Lovekesh.Kakk... - &5 X
Architecture  Structure  Steel  Systems Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools ~ Modify o
= G-~~~ = . A M g+ O == |0 . 5 Autodesk Revit 2020 - CW02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site < v o
= T ) v ¢ - 7 i == | "% {3 Lovekesh.Kakk... - &5 X
Architecture  Structure  Steel  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools ~ Modify o
Select ¥ Build Circulation Model Room & Area ¥ Opening Datum Work Plane
Properties - - . v
——— DWG Export !
A
Select Export Setup
<in-session export setup> v E g
i ?
Floor Plan:  efect Views And Sheets To Export Modify DWG/DXF Export Setup X
Graphics . Everythin:
i . Si Export: 9 Select Export Setu|
View Scall Preview of Floor Plan: Site - . o | Layers Lines Patterns Text & Fonts Colors Solids Units & Coordinates General
{ Show in list: All views and sheets in t| -
Scale Valy Export layer options: Export category properties BYLAYER and overrides BYENTITY v
Display M M ED ) CheckAl | Chi
Detail Ley Load layers from standards: American Institute of Architects Standard (AIA) v
Parts V|5|! Include I Type l
Visibility/( Cateao Projection Cut A
Graphic O > 3D View: N gy Layer Color ID Layer Layer Color ID Layer
Orientatid 3D View: —I Model categories
Wall Join & Air Terminals M-HVAC-CDFF |50
Nicrinlina & Elevation: + Areas A-AREA 32
Properties | ) + - Cable Tray Fittings E-CABL-TRAY 211
| #  Elevation:| + Cable Trays E-CABL-TRAY 211
Project Brg ) (A
- OV { - Elevation: ik Caééwork Q-CASE 31 Q-CASE 31
v S I + Ceilings A-CLNG 13 A-CING 13
i o Elevation: | + Columns A-COLS 52 A-COLS 52
: Communication Dev... E-COMM 2
@ Floor Plany + Conduit Fittings E-POWR-CNDT | 130
L u Floor Plan +/ Conduits E-POWR-CNDT | 130
€ + Curtain Panels A-GLAZ-CURT 52 A-GLAZ-... 52
30 [~ ™ Floor Plan + Curtain Systems A-GLAZ-CURT |52 A-GLAZ-.. 52
k Ele 4+l Curtain \Wall Mullinne A2l A7.C\\N g1 A.QI A7 g1 N
E Le < >
&= N Next... Save Set & Clq I
Sch BDhE R Expand Al Collapse All | Add/Edit Modifiers for All..
Shé..w ..,
+ @ Families
+ 0] Groups cancel
& Revit Links
v
1:100 O KERE > ¢ (RIS <
Ready i & 0 B 2 Main Model P &£ 0 K OFo




Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

= Tab > Layer > Choose: Export Layer
options

= Tab > Layer > Choose: Load layers from
Standards

REGHG &-2-@2-FPA G- NG~

Architecture ~ Structure  Steel ~ Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate ~ View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools ~ Modify

Select ¥

Build

Autodesk Revit 2020 - CWO02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site

Properties

Floor Plan:

Graphics
View Scal
Scale Val
Display M
Detail Ley
Parts Visi
Visibility/t
Graphic O
Orientatid
Wall Join
Nicrinlina
Properties
Project Brd
= :D: Viey
=1 Flg

Ce
3D
+ Ele
Leg
[ sch
[ she

EaRca RS

&

[Q] Grof

&9 Revi

=+

Ready

DWG Export

Select Export Setup
<in-session export setup>

Select Views And Sheets To Export

Preview of Floor Plan: Site

e

@ Families

ups
it Links

<« Bf R lovekeshkakk.w Y¢ (@) -

Work Plane

@~
Circulation Model Room & Area ¥ Opening Datum
? X
BN,
Modify DWG/DXF Export Setup ? X
Export: Everything Select Export Setu
= ] . P " Layers Lines Patterns Text & Fonts Colors Solids Units & Coordinates General
Show in list: All views and sheets in q )
Export layer options: | Export category properties BYLAYER and overrides BYENTITY v|
HDhE R Check All a&
Load layers from standards: | American Institute of Architects Standard (AIA) v|
Include | Type |
o Projection Cut A
) atego
] 3D View: N gory Layer Color ID Layer Layer Color ID Layer
. =1 Model categories
3D View: {
© Air Terminals M-HVAC-CDFF 50
#  Elevation:]| 4 Areas A-AREA EP)
) i+ Cable Tray Fittings E-CABL-TRAY 211
®  Elevation:] 4 Cable Trays E-CABL-TRAY 211
o Elevation: 5| Ca‘s-ework | Q-CASE 31 Q-CASE 31
4 Ceilings A-CLNG 13 |A-CLNG 13
“ Elevation: | +/ Columns 'A-COLS 52 A-COLS 52
i I Communication Dev... E-COMM 2
[ Floor Plan] ) Conduit Fittings E-POWR-CNDT 130
Lj Eloor Plan -+ Conduits E-POWR-CNDT 130
| + Curtain Panels A-GLAZ-CURT |52 A-GLAZ-... 52
M ™ Floor Plan | Curtain Systems |A-GLAZ-CURT 52 |A-GLAZ-... 52
4+l Curtain \AWall Mullinne A-2I A7.C\N g1 ARl A7 g1 4
< >
Next... Save Set & G% .
i) B Y Expand Al Collapse Al Add/Edit Modifiers for Al...
Concel

1:100 O SERE> 0 (RAIE <

i

":_ -0 ' .;.‘ Main Model

=

?‘A“%ﬁ: 0?30

4




Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

Tab > Solid > Choose: ACIS solids

R PBeH@-A->-8 -7 0A G- e L R Autodesk Revit 2020 - CWO02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site « 1 ‘ Lovekesh.Kakk..w Y @ B - =
Architecture ~ Structure  Steel ~ Systems Insert  Annotate  Analyze  Massing & Site  Collaborate ~ View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools ~ Modify Oh
i i < o,
v v . v » v I . - v -
Select ¥ Build Circulation Model Room & Area ¥ Opening Datum Work Plane
Properties =
P DWG Export ? X
Select Export Setup
' <in-session export setup> N,
Floor Plan:  Select Views And Sheets To Export Modify DWG/DXF Export Setup ? X
Graphics ) ) Export: Everything | Select Export Setu
View Scall | Freview of Floor Plan: Site ’ r i n Layers Lines Patterns Text & Fonts Cofors Solids Unity & Coordinates General
Show in list: All views and sheets in t|
Sc.ale Val | Export solids as: (for 3D views only)
D'SP'TVM DMOET | chekal | Ch O polymesh
Detail Ley i
P -4 (®) ACIS solids
arts Visi| Include I Type I
Visibility/
Graphic O ] 3D View: N
Orientatid ] 3D View: {
Wall Join J/
Nicrinlina “ Elevation:
Properties
ﬁ Elevation:
Project Brg 1
= 0. Vie “ Elevation:
= Flg “ Elevation:
B Floor Plan
W ce @ Floor Plan;
[+ 30 [~ ™ Floor Plan
[+ Ele
Leg Next. Save Set & CI;
o | noE*
[- E— Y
Ex) % Families
[+ [ﬂ Groups oo
&3 Revit Links

Ready

1:100 Ok KWME> 0 RIS <

ot

E‘ -0 . 5 Main Model

FTELEK" OYo
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Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

= Tab > Units & Coordinates > Choose >
Meter & Shared CS

= Click OK & Next/Save set and close

REcHG Q-»-82-FO0A G- Q5 Y%

Select ¥

Properties

Floor Plan: Sit
Graphics
View Scale

Scale Value I
Display Mod
Detail Level |
Parts Visibilit;
Visibility/Gral
Graphic Dispi
Orientation |
Wall Join Disi

Nicrinline

Properties hel

=1 Floor |
Le
Le
Sil
i+ Ceiling
+ 3D Vie

DWG Export

Select Export Setup

<in-session export setup>

Select Views And Sheets To Export

Preview of Floor Plan: Site

—

=

B8

[+ Elevations (Building Elevation)
Legends

T Schedules/Quantities (all)
Sheets (all)

@ Families

[@] Groups

&8 Revit Links

Ready

1:100 O KEWME2 0 RIS <

ot

"_'_ -0 . .;‘ Main Model

B = Autodesk Revit 2020 - CW02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site <« B8 R lovekeshKakk.” Y2 (@) - - =
Architecture  Structure  Steel ~ Systems Insert  Annotate  Analyze  Massing & Site  Collaborate ~ View  Manage  Add-Ins  Quantification  Site Designer ~ BIM Interoperability Tools  Modify B~
' F Model Room & Area ¥ Opening Datum Work Plane
Modify DWG/DXF Export Setup ? X P
H Select Export Setu
Export: Everything e . P Layers Lines Patterns Text & Fonts Colors Solneral
Show in list: All views and sheets in the Model v One DWG unit is:
PME T checkal Check None O Foot
O1lnch
Include | Type | Name &
S 3D View: Navis export O Centimeter
O Millimeter
@ 3D View: {3D;
“ Elevation: East Coordinate system basis:
O Project internal
V| - .
“ Elevation: North
i) Elevation: South
#  Elevation: West
Eﬁ Floor Plan: Level 1
Eﬁ Floor Plan: Level 2
LD Floor Plan: Site
Next... Save Set & Close Canc ik B ¥
OK Cancel

?‘&‘%‘b 0?30
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Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

Choose > Output folder location
Choose > AutoCAD Drawing Version

Choose > Short name / Long suffix is
also available to choose for naming

Tick > Export views on sheet and links as
external references

REGHG &-2-@2-FPA G- NG+

Architecture ~ Structure  Steel

Select ¥

Properties

Systems

Insert

Build

Annotate  Analyze

Floor Plan

Floor Plan: Site

Graphics

View Scale

Scale Value 1:

Display Model

Detail Level

Parts Visibility
Visibility/Graphics Overrides
Graphic Display Options
Orientation

Wall Join Display

Nicrinline

Properties help

= 0. Views (all
=/ Floor Plans
Level 1
Level 2
Site
i+ Ceiling Plans
4 3D Views
[+ Elevations (Building Elevation)
Legends
T Schedules/Quantities (all)
Sheets (all)
i % Families
() [@] Groups
&8 Revit Links

Ready

1:100

100

Normal
Coarse

Show Original

Edit...

~ B Edit Type

PN

Edit...

Project North
Clean all wall joins

Architactiiral

Apply

Project Browser - CWO02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt

Massing & Site

Autodesk Revit 2020 - CWO02 - Prepare your Civil 3D drawing for Exporting Out(Start).rvt - Floor Plan: Site

Collaborate  View Manage  Add-Ins

Circulation Model

Quantification

Site Designer  BIM Interoperability Tools ~ Modify

- - v
v

Room & Area ¥

o |

R Export CAD Formats - Save to Target Folder

? X P

File FloorPlan-Site

Status Date modified Type Si.

This folder is empty.

| Files of type: AutoCAD 2018 DWG Files (*.dwg) v

Naming: Automatic - Short

v

Todls v

| Export views on sheets and links as external references

1:100 O KWME 2 0 RIS <
ot

":_ -0 . 5 Main Model

@~

Opening

T @ X -

« B8 R LovekeshKakk.” Y@ (@) - - & X

Datum Work Plane

d

>
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Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

All the sheets are now stored in to the
desire folder location

Pinto Quick Copy Paste

| ¥ = | Output

Home Share View

* o Cut

Wl Copy path

access
Clipboard

v

U4. Data trom leam
Accelerator

Other
@ OneDrive - Personal

= This PC
» 3D Objects

B 8iM 360
22 items

[#] Paste shortcut

X I ¥ New item ~
i e o
__ 7 | Easy access ~
Move Copy Delete Rename New
to~ to~ < folder
Organize New
A
~ Name

i4 Open ~ = selectall

A 3DView-(3D}dwg
| 3DView-{3D}.pcp
,’ 3DView-Navis_export.dwg
_ 3DView-Navis_export.pcp
,’ Elevation-East.dwg
_ Elevation-East.pcp
’ Elevation-North.dwg
_ Elevation-North.pcp
’ Elevation-South.dwg
_ Elevation-South.pcp
’ Elevation-West.dwg
_ Elevation-West.pcp
,’ FloorPlan-Level1.dwg
_ FloorPlan-Level1.pcp
,’ FloorPlan-Level2.dwg
_ FloorPlan-Level2.pcp
,’ FloorPlan-Site.dwg
_ FloorPlan-Site.pcp
’ ReflectedCeilingPlan-Level1.dwg
_ ReflectedCeilingPlan-Level1.pcp
,’ ReflectedCeilingPlan-Level2.dwg
| ReflectedCeilingPlan-Level2.pcp

v
Edit |~ Select none
Propverties @ History j‘L Invert selection
Open Select
CW02 > Output

Status Date modified Type Size
QR AutoCAD Drawing
O~ PCP File

0~ AutoCAD Drawing
o1 PCP File

©-8 AutoCAD Drawing
23 PCP File

oA AutoCAD Drawing
23 PCP File

oA AutoCAD Drawing
2 PCP File

oA AutoCAD Drawing
23 PCP File

oA AutoCAD Drawing
o1 PCP File

(-} AutoCAD Drawing
2 PCP File

o8 AutoCAD Drawing
oA PCP File

QR AutoCAD Drawing
o8 PCP File

oA AutoCAD Drawing
o8 PCP File

499 KB
23 KB
500 KB
23 KB
311 KB
23 KB
275 KB
23 KB
274 KB
23 KB
311KB
23 KB
16 KB
23 KB
16 KB
23 KB
1,160 KB
23 KB
15 KB
23 KB
15 KB
23 KB

22 items

v O

X
~ @
Search Out... @




Workflow - Import Data from Revit to Civil 3D

You can save setup settings to use in other Revit projects

'u'( ivil 3D Autodesk Civil 3D 2020 FloorPlan-Level1.dwg

(1] LovekeshKakk.>~ Y A~ @ -

Geolocation o

Open Drawing file in AutoCAD

Location Tools Online Map
FloorPlan-Level1*

TOOLSPACE [~1[Top][2D Wireframe]

€ Drawing Settings - FloorPlan-Level1

Active Drawing Settings View

E:I ~ Units and Zone |Transformation |0bject Layers |Abbreviaﬁons |Ambient Settings |

Ty
i ; General : Drawing units: Imperial to Metric conversion: Scale:
& .
Point Meters ~  International Foot(1 Foot = 0.3048 Meters) ~ | 1:1000 v

O Surface

+ & parcel Angular units: [ Scale objects inserted from other drawings Custom scale:

#O Grading Degrees [[] Set AutoCAD variables to match 1000

7= Alignment . 7

i M i o

& b gro?:e Vi £ Categories: UTM, WGS84 Datum O
rofile |ew. . 5 . . . = .

+@ Superelevation View Available coordinate systems: N Q

HE Cant View | UTM-WGS 1984 datum, Zone 43 North, Meter; Cent. Meridian 75d E ‘t:‘l 7

#[ Sample Line T

4 Section Selected coordinate system code: | UTM84-43N >

\ s

Description:
UTM-WGS 1984 datum, Zone 43 North, Meter; Cent. Meridian 75d E

#a Section View

#% Mass Haul Line
+2% Mass Haul View
#[ Catchment

+1 Pipe Network
& Pipe

+© Structure

# 30 Pressure Network
& Pressure Pipe
¥ Fitting

#% Appurtenance

+M Corridor

# 4% |ntersection

Hé Assembly

#®& Subassembly

8 Quantity Takeoff
#7 Survey

#[5 View Frame Group
+E View Frame

Projection:
UTM

Datum:
WGS84

,

{ i x B=1~ Type a command s
ixX yp -
| Iz Nix v @dutmsa-a3n~ & 1:2137.41~ |f  273013.5839, 2712036.5926,0.0000 MODEL HE 8 v || &~ % v L [~ R X A 11~ £~ + @& 14000 0 @ A T =

-

:



Streamline data sharing Civil 3D, Revit & InfraWorks

What you’ll learn today

Coordinate System ? Collaborate with Civil 3D Collaborate with Revit Collaborate with
Infraworks

* Coordinate System: What? Why? * Infraworks to Civil 3D «  Workflows: Assign, Acquire, «  Workflows: Revit, FBX, IFC &
How? * Reuvit to Civil 3D Publish Coordinates to Revit Civil 3D to Infraworks
» Understand Coordinate System * Prepare your Revit Model for * Prepare your Infraworks Model

for Products exporting out for exporting out




Revit Workflows

Interoperability between Revit and other products

= RWO01 - Assign Coordinates in Revit

« Import LandXML ‘1 Set Ba

(With/Without CAD Drawing) o

Properties

@ 3D View

IBD View: Navis_export

= RWO02 - Import LandXML Using Site —

Detail Level
Parts Visibility S
Visibility/Graphics Overrides

|
Graphic Display Options
Discipline C D
Show Hidden Lines B]

Default Analysis Display Style
Sun Path
Extents
Crop View
Crop Region Visible
Annotation Crop
Far Clip Active
Far Clip Offset

= RWO3 - Acquire coordinates ==

Properties help

Project Browser - RW2 - Import La
=] :D: Views (all)
=) Floor Plans
Level 1
Level 2
Site

= RWO04 - Publish coordinate from =

Navis_export

u 30}
=) Elevations (Building Elevati
evit to
North

South
West
Legends
[ Schedules/Quantities (all)
Sheets (all)
@2 Families
@-[@] Groups
&5 Revit Links

Click to select, TAB for alternates,

-

(%) 4.00

=)~ Type a command

poo

REVIT60-DefaultLocation



Collaborate with Revit

(RWO01):
Assign Coordinates in Revit (With/Without CAD Drawing)



Assign Coordinates in Revit

Survey point is the key!

= Define the survey point coordinates
values to match a known point in the
physical world

= Use survey point coordinates from the
civil engineer, or determine the
coordinates of a known location, such as
a geodetic survey marker or benchmark
or the intersection of 2 property lines

= Project base point will automatically be
updated to establish a reference for
measuring distances and positioning
objects within the context of the model

)
Architecture Steel  System: nsert no
% K Notch ~
- ‘&=
Modify O Qu = 0
= ¥ Goin- &
Select v Properties Clipboard = Geometry
Modify | Project Base Point
Properties X p wser
L s (all)
= S
' Level
Level
Project Base Point (1) v Site
Identity Data 2 eiling P!
N/S 27120349300 teve:
E/W 2732482481 Ie"e
Elev 2740000 1l T | Navis.export
Angle t orth 0.00°

,
fZ2mpan
3QTL8E

—] - Elevations (Building Ele

SSSSS

ooooooooo

Apply

Modify

vation)

View  Measure  Create

TP A3 B (b W O W



Assign Coordinates in Revit

Make sure you are using the correct units!

] ] [ ] ] [ ] [ ]
= As civil engineers work with specific RE©BG->-©-0 =/ oA G oE%S - s e - oo i o (B Qoo W O
ZICHN  Architecture  Structure  Steel  Systems Insert Annotate  Analyze Add-Ins  Quantification Modify

Massing & Site Collaborate  View  Manage Site Designer  BIM Interoperability Tools &~

units, you may want to consider to ) (R Ee

Select » Settings Project Location Design Options Manage Project Phasing Selection Inquiry Macros Visual Programming

change the units in your Revit project in = i

order to be aligned with them (Manage g

Graphics L] gy
. eve
Scale Value 1 100 R - .
=} Elevations (Building Elevation)
Display Model Normal East
Detail Level Coarse North
Parts Visibility Show Original South
Visibility/Graphics.. | Edit. | West
Graphic DisplayO.. | Edit. | ¥ Legends
Orientation Project North ™ Schedules/Quantities (all)
Wall Join Display  Clean all wall joins D) Sheets (all)
Discipline Architectural + Families Proiect Units
- - stnimiues H Groups roject Units Format X
Show Hidden Lines By Discipline x
&9 Revit Links
Color Scheme Loc... Background Discipline: Common v Use project settings
Color Scheme <none> | [
= i ~ ;
System Color Sche... | s 1 — Units: Meters E ]
Default Analysis D.. None Length 1234.568 [m] ] )
S P U e 22 ! 3 deon;l v | 0.001
—— " Volume 123457 m* | piaces '
Range: Base Level None Angle 12.35° } Unit symbol:
Range: Top Level Unbounded Slope 12.35° | None e
: o Currency 123457 i
Underlay Orientati... Look down -
- Si trailing 0
T i Mass Density 123457 kg/m® | O AUNMS Vnng s
Crop View D Time 12346 I Suppress 0 feet
Crop Region Visible O Speed 1234.6 km/h f Show + for positive values
Annotation Crop  [] O [[Juse digit grouping Q
View Range Edit... | Suppress spaces
Associated Leve Level 1
Scope Box None v Cancel
Depth Clipping No clip |
e e—————— 4 Decdmal symbol/digit grouping:
Identity Data 2
i } 123,456,789.00 ~
View Template <None>
View Name Site
Dependency Independent oK Cancel Help
Title on Sheet
Referencing Sheet
Referencing Detai
Phasing £
Phase Filter Show All
Phase New Construction
i . -
Properties help Apply 1:100 Ok SERE> 0 (BRAIE <

Ready i) £ © W A Main Mode TEXBR OV

4



Assign Coordinates in Revit

Display the survey point

= (o to any floor plan
Site plan recommended

Autodesk Revit 2020 - RW1 - Assign coordinate system in Revit - Floor Plan: Site

REcHG - R-#-Q2-FO0A -0 18-+

ZICHN  Architecture  Structure  Steel  Systems Insert Annotate  Analyze Massing & Site  Collaborate  View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools

- ‘é Manage Images

Links :Q: Starting View

Phasing Selection

Open “Visibility and Graphic Display*
dialog

= Display survey point 2\
= Display project base point (optiona

= Reuvit internal origin, Project Base
Point and Survey Point are
at the starting of a project all situated in the
same place (0,0,0)

% @ E’* Object Styles E‘é Project Parameters t“é Transfer Project Standards EE Structural Settings ~ % @ Location
Modify| Materials A snaps o Shared Parameters IJ] Purge Unused 8 MEP Settings Additional _ l2. Coordinates ~ Design
[‘ﬁ Project Information (E Global Parameters ‘% Project Units CB Panel Schedule Templates ~  Settings @ Position ~ Options Main Model v
Select = Settings Project Location Design Options
Properties X  Project Browser - RW1 - Assign coordin... X [ Site X
=10 Views (all)
@ Floor Plan -~ Floor Plans
Level 1
Level 2 O
Floor Plan: Site | B8 Edit Type Site :
Graphics —| - Ceiling Plans
View Scale Level 1
Scale Value 1 100 Le,vel 2 o .
=} Elevations (Building Elevation)
Display Model Normal East
Detail Level Coarse North
Parts Visibility Show Original South
Visibility/Graphics... i West
Graphic Display O... | B Legends
Orientation Project North o ™ Schedules/Quantities (all)
Wall Join Display  Clean all wall joins Sheets (all)
Discipline Architectural &) Families
Show Hidden Lines By Discipline # [@) Groups
Color Scheme Loc... Background @8 Revit Links
Color Scheme <none>
System Color Sche... Edit...
Default Analysis D... None
Sun Path O
Underlay L
Range: Base Level None
Range: Top Leve Unbounded
Underlay Orientati.... Look down
Extents A
Crop View O
Crop Region Visible []
Annotation Crop [ Q &
View Range Edit...
»‘\‘,-:vt,k ated Leve L::c.
Scope Box None
DepthClipping | Nodlip |
Identity Data L
View Template <None>
View Name Site
Dependency Independent
Title on Sheet
Referencing
Referencing Deta
Phasing L
Phase Filter Show All
Phase New Construction
N APPly 1100 )k G 0 RAIE <
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. dit 0 [= 3 Main Mode

« 08 R danielmoralt..~ W (@) -

= B 3

Inquiry Macros Visual Programming

W43 B (b M & Po

('CU Dynamo Dynamo
' Player

q



Assign Coordinates in Revit

Define real world coordinates to the survey point (N/S and E/W)

[ ] [ ] ] ]
. U nCI I Su rve OI nt I n Order to defl ne the R@ EELTA'@' SR = S-70A Q'Q “',E-: Autodesk Revit 2020 - RW1 - Assign coordinate system in Revit - Floor Plan: Site ‘gﬂ‘daniel.moral.t...' =) @,
Architecture  Structure  Steel Systems Insert Annotate  Analyze Massing & Site  Collaborate View Manage Add-Ins Quantification  Site Designer  BIM Interoperability Tools ~ Modify | Survey Point o~
p ¥ Notch ~ Y] ¢a oo Q -
- . ‘ [}, Sat - & %’& _ SRV AR
rignt coorainate vaiues . B oy 58

Geometry Modify View  Measure  Create

= O Views (all)
—| - Floor Plans
" " " . Level 1
. D Level2 . SuneyPoint - Intemnal
efine northing) an eastin - y
Identity Data L] = Ceiling Plans N/S 2712096.3770
N/S Level;
. - E/W . Leyel o _ Elev 0.0000
values of a desired location — s i A=
Geolocation L] North
Lat South
Lon West

+ Families

+
§Z2BPnn
F9TS4R

= N/S=Y, E/IW=X, Elev=Z

= Survey point will move to a new position.
Do not worry about the current position of
the survey point in the floor plan

N/S=2712096.377 m, E/W=273316.399 m
Elev=274.000 m

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. &t r 0 [= 2 Main Mode 9 43 &y (h M & Pn



Assign Coordinates in Revit

Define real world coordinates to the survey point (Elevation)

] [ ] [ ]
. D IS Ia Su rve OI nt and ro eCt base R@ eHB-KR-~- -7 OA @'Q %A+ Autodesk Revit 2020 - RW1 - Assign coordinate system in Revit - Elevation: South « 08 R danielmoralt..~ W (@) - - N x
Architecture  Structure  Steel  System: nse Anno Analyze Massing & Site  Collaborate  View Manage Add-Ins Quantification  Site Designer  BIM Interoperability Tools ~ Modify | Survey Point (03 L4
u L | ] ] % Notch ~ cis oio ‘;‘ .
point) in an elevation view - : : ~

Geometry Modify

= Define elevation value (survey point is still == - %

aaaaaaaaaaa

unclipped) —

—] - Elevations (Building Elevation)

+ Families

= Moving an unclipped survey point moves -
only the survey point relative to the shared
coordinate and the project coordinate yoEED
systems: e e

= Project coordinates do not change for
the model elements

= Shared coordinates do not change for
the model elements

= Only the shared coordinates of the
survey point itself change oo~



Assign Coordinates in Revit
Place the survey point at the desired location (N/S and E/W)

- Clip Survey pOint @ REGHG -®-7-Q2-FOA G- %8B+

Architecture  Structure  Steel  Systems Insert Annotate Analyze Ma

I( Notch ~ Q’j
M?dify ] Gl - &8 - %} &
Bl "y @ e B

eeeeeee

= Move the survey point to the desired e T
location (provided by civil engineer)ina = . =

Identity Data 2 = Ceiling Plans

floor plan matching with the values we just ..~ . ==
defined

Autodesk Revit 2020 - RW1 - Assign coordinate system in Revit - Floor Plan: Site

« 08 R danielmoralt..~ Y@ @ -

o=

ssing & Site  Collaborate  View Manage Add-Ins Quantification  Site Designer  BIM Interoperability Tools ~ Modify | Survey Point

= N/S (northing), E/W (easting), and
elevation values have not changed

1:100 O GME> 0 (RALIE <
select, TAB for alternates, CTRL adds, SHIFT unselects. &t

&0 =] vain Mode W AR S (b My O P



Assign Coordinates in Revit

Place the survey point at the desired elevation

= Move the survey point to the desired e e e e e B
u u n ] n [ (Isz::txcn&:]j && e oo i ';i.=
elevation in an elevation or section view == Lo a0
. . . . Selec-t - Propeme»s Clip Geometry Modify R e e e e e
matching with the value we just defined T . X S
(survey point is still clipped) e

=] Elevations (Building Elevation)

= N/S (northing), E/W (easting), and
elevation values have not changed

+ =+
§ZEEam
792588

= Moving a clipped survey point repositions
the shared coordinate system relative to
the model geometry and the project
coordinate system:

= Project coordinates do not change for
the model elements

= Shared coordinates change for the I
model elements B

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. &t L 0 [=2 Main Mod 7 43 &y (h ¥y & o

..................



Assign Coordinates in Revit
Check it & Pin it!

u ff ]
. CheCk d I erent S OtS COO rd I nateS Of R@ BB[.AA'CQ' v~ ) gv;‘;@ A @vo x' Autodesk Revit 2020 - RW1 - Assign coordinate system in Revit - Floor Plan: Site ‘m‘d lllllllllllllll = @
Architecture  Structure  Steel Systems Insert Annotate Analyze Massing fSt Collaborate View Manage Add-Ins Quantification Site Designer  BIM Interoperability Tools  Modify | Survey Point (o B
[ | ] Q ¥€ Notch ~ Y] E & gs oo 0% P - g i
i f«j Cut ~ “‘: 90 N B AP? - =; >
Modify| [T : + . ol ) "
Known geographlcal pomts to make sure | B oy o bk B [: (% & S
Select v Properties Clipboard Geometry Modify View  Measure  Create

Modify | Survey Point
e WOIKTIOW Was correcC e L
10, Views (all) Y f { _— 0 A
—] - Floor Plans S / {
u L] N Level 1 [~ ~l o~ / ."
d ' ' l Level 2 i~ ‘ =~ ." .“ - -
O n e n n O a e a I e n S I O n S a n e Survey Point (1) v|B Site :':7 ‘ : I‘I ‘\' ‘ Survey Point -In(evnélx_f__
Identity Data & =I- Ceiling Plans St gy f / _— 0 Shared Site._—
N/S 27120963770 Level 1 ~ f / - NIS—2712096 3770
E . E/W 733163990 Level 2 —~——F f f [ " EMW 273316.3990
> p Ot C O O rd I n a te ) 574,000 - 3D Views = c‘ / v Elev 274.0000
. R Navis_export i
Geolocation & (3D) —
-t ] Elevations (Building Elevation)

SSSSS

57 Legends

= Pin it (optional) to ensure that the Survey
Point does not move inadvertently
(Modify tab > Modify panel > Pin) d

= Create a 3D view and name it with
"navis” prefix as InfraWorks looks for a
Revit view with this name to import first.
In this view you can control the elements
transferred turning off the categories that
are not needed

Apply
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Gl L 0 [= 24 Main Mod 9 43 By (h My & o



Assign Coordinates in Revit

Video — Assign projected coordinates Iin Revit model to the Survey Point

1 Autodesk InfraWorks - Mount_Abu,Rajashtan,India - o X

(2] e




Collaborate with Revit

(RWO02):
Import LandXML Using Site Designer



Import LandXML Using Site Designer

Overview

= You can share a site model between Revit and
AutoCAD Civil 3D through LandXML files

= LandXML is co-developed by Autodesk
= Revit supports imported XML, using Site Designer

= Site Designer for Revit® is an extension (add-in) for
the Revit software. It is available to Autodesk
subscribers of a supported Revit product or suite

= For this workflow you will need: Land XML
« Civil 3D C—) R
= Reuvit C3D Site Designer |

= Revit add-in Site Designer



Import LandXML Using Site Designer

What to do in Civil 3D

The LandXML import and export B EL D8 o

nnotate Modify Analyze View Manage @ Output |Survey Rail  Transparent In

N BN EERE

functionality is based on the LandXML S— NN
SChema. AUtOdeSk CiViI 3D Su ppOrtS the Create View Create Create Plot Batch Previ\ew \:ewDetalls Expor-tTMX Expo-:to Exportz:fiIBD Reha

Frames Sheets Section Sheets Plot lotter Manager LandXML  Drawing

following LandXML schema versions:
= LandXML-1.0, 1.1, 1.2

.-E Plotter Manager  LandXML

ames eets ectlon hcets Plot i ¥ Exportto S Exp . .
ppppppppppp ion Plot . port Specify objects to be exported:
Start Si le_Civil3D_Plain EG* X +
ar ample_Civil3D_Plain BAJ |:EVJ |E|&] |L—|&]
i TOOLSPACE —][Top]I2D Wireframe !

Export a LandXML topography using — e

PPPPPP

----- ~2 [[] Centerline Alignments
''''' t} [] Offset Alignments
_l [] Curb Return Alignments
= [] Rail Alignments

" - Puoi":ce: 6 - Site-01
followin g ste PS. é-- (OB
Site: : o j g
Catc
Pipe

ssemblies

= Qutput tab > Export to LandXML
= Check or uncheck the boxes to filter the =" | R

=- 31l O] Pipe Networks

data that you want to export ;jﬁmmm
~~~~ [] Pressure Networks
----- A [] Corridors

Specify LandXML version:
12 ]

= Use Pick from drawing tool to select
data manually

= Specify the LandXML schema version

[ Cancel




Import LandXML Using Site Designer

Assign coordinate system into Revit

B B efO re yO u i m pO rt La n dx I\/I L fi I e i n to Rev it yO u Autodesk Revit 2020 -|RW1 - Assign coordinate system in Revit.rvt -
. . . . View Manage Add-Ins Site Designer Modify | Survey Point =~
nm eOedde;[o assign coordinate system into your Revit S . | E‘ » Ot E

es
Settings  Settings Templates Settings @ Position ~ Options Main Mod

Project Location Design O

= The workflow “Assign coordinate system into
Revit" is covered by the workflow RWO01 of this

accelerator y grepmetnens

g | M e
= |In order to understand how the geo-referenced e
coordinates can be applied in Revit, we strongly
recommend to watch workflow RWO01 materials

= Finally, for the import of LandXML you can use the
Revit file from RWO01 which is already prepared
and contains the assigned geo-referenced
coordinate system, aligned with the Civil
3D model




Import LandXML Using Site Designer

How to import LandXML toposurface in Revit

= Start Revit and open the prepared file
= Tab > Site Designer

REecHG-R-~- Q@ -7 90A @-055 iB-- Autodesk Revit 2020 -
B CI i Ck On I m Ort L an dXM L Architecture  Structure  Steel Systems Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Site Designer |
p & Soft Terrain wa, Sidewalk & Soft Terrain wef Sidewalk
« Import LandXML ‘! Set Base Toposurface @ Street @& Street
= e ﬂ . I 2 Feature Line u R e = Parking Lot ?/ Feature Line " R o = Parking Lot
. . ~ Export Lan oposurface Convers ion ' . etaining Wa _ ' etaining Wa
= Select the LandXML file to import S poit peou s cub G pointWpeou o cut
Import/Export Convert Locate Modify F

= Uncheck the “Import alignments found in

LandXML file”, unless you exported alignments "R import LanchL ==
with your Civil 3D LandXML file Seect Fie o Inpot

File Name: C:\Site Designer Workflow\Sample_Civil3D_Plain EG xml| [_]

= Set POSitiOning to “By Survey POint” ' V| Import toposurfaces found in Land<ML file

| Import alignments found in LandXML file

- T h en CI | C k O K Paositioning: By Survey Point v

0K [ Cancel




Import LandXML Using Site Designer

How to import LandXML toposurface in Revit

Land XML contains more than one
Rename the toposurface if needed

Import the toposurface

Select the toposurface you need to import, if the

Assign the toposurface to a specific project phase

Architecture  Structure  Steel  Systems Inset Annotate Analyze Massing &Site  Collaborate  View  Manage  Add-Ins  Site Designer  Modify D~

= i 23 A Y, Location = Manage Images a8}
L @PN G B LA @ % Of B B B » Y- B g @i B 1
Modify| Materials Object Snaps  Project Project Shared Global Transfer Purge Project Structural MEP Panel Schedule _  Additional [A‘ SRS © Design Manage iy Decal Types Phases
Styles Information Parameters Parameters Parameters Project Standards Unused Units Settings T Settingsv Templates T Settings v @ Position ~ Options Main Model ~  Links :L‘E Starting View 'ﬁ Edit
Select v Settings Project Location Design Options Manage Project Phasing Selection
Properties X fid Navis_export [ site = (30} X
@ 3D View v

3D View: {3D} vl 5 Edit Type
Graphics A a

View Scale 1:100 B

Scale Value 1: 100

Detail Level Medium

Parts Visibility Show Original

Visibility/Graphics Overrides [ Edit... £

Graphic Display Options [ Edit...

Discipline Coordination

Show Hidden Lines By Discipline

Default Analysis Display Style None

Sun Path =]
Extents

Crop View [

Crop Region Visible ]

Annotation Crop ]

Far Clip Active

Far Clip Offset 304.8000

Scope Box None

Section Box [l v
Properties help Apply

Project Browser - RW1 - Assign coordinate system in Revit.rvt
-0, Views (all)
=) Floor Plans
Level 1
Level 2
Site
=) Ceiling Plans
Level 1
Level 2
= 3D Views
Navis_export
(3D}
(=) Elevations (Building Elevation)
East
North
South
West
Legends
= Schedules/Quantities (all)
Sheets (all)
o1 Families

X

===

Highlight the toposurface(s] that you wish to import into your model

-
R Toposurface Selection

_Name Description

[

7

R Toposurface User Information

Toposurface User Information

MNumber of Points 4722

@ Add as a New Toposurface

Toposurface Name Site-01

Phase Created:

() Dvenwrite existing Toposurface

Select toposurface to Ovenwrite v

Cancel

User Information

/_]A The import process is done.

OK




Import LandXML Using Site Designer

How to import LandXML toposurface in Revit

= Open the view > Floor Plan > Site

= The toposurface should be located at
the correct position

= Note: when importing topography via
LandXML, Revit retriangulates the
toposurface and it could create less
accurate surface, so make sure to
double-check the final result




Import LandXML Using Site Designer

Video — Import a LandXML toposurface in Revit

= = El :‘, ':—_ E{ - - . ¢CMI3D v Autodesk Crvil 3D 2020 RW2 - Import LandXML Using Site Designer.dwg » Type a keyword or phrose "M ! aleanderbew..r > A~

Insert  Annotate  Modify Analyze View Manage Output  Survey Ra Transparent InfraWorks Collaborate Help  Add-ir Exg Tools Featured Apps = Geolocation o -

<! Points ~ & Parcel ~ ¥ Alignment ~ #® Intersections *+ &2 Profile View ~ e T D < Move () Rotate N Trim v ‘/ o dmo i B
r
v 0" Copy AN Mirror a r.

& Surfaces ~ *) Feature Line ~ & Profile ~ 4% Assembly ~ ~#% Sample Lines v () - ~ Fillet % - %o £, 7. . 25 Make Current
y

Paste
rF a2

3E Traverse ~ &% Grading ~ B Comdor ~  J% Pipe Network ~ @ Section Views ~ - & 1__,[ v ;‘. Stretch b] Scale 55 Amay ' Properties =’9 g, e T -"6 Match Layer H E&

Palettes ~ Create Ground Data ~ Create Design ~ Profile & Section Views Draw ~ Modify ~ Layers « Clipboard
Start RW2 - Import LandXML Using Site Designer* * +
: TOOLSPACE [=)[Top)|2D Wireframe)
[ ‘= ® H
Active Drawing View v
[ RW2 - Import LandXML Usin...

'@' Points

[0 Point Groups
+ O Surfaces

#-F Alignments

./ Feature Lines
Eﬁl Sites
(6] Catchments
M Pipe Networks
m Pressure Networks
Corridors
&8 Assemblies
5 Intersections

- R Survey
[ View Frame Groups

=) [Z] Data Shortcuts []

Cé Surfaces

- -3 Alignments
I3 Pipe Networks
3@ Pressure Networks
B Corridors

[5g view Frame Groups

R =)~ Type @ command 7

272515.740, 2712286.937, 0.000 MODEL Hf ::: G- -0 R A A 1000 £ -4 G0 @ 3500 3=




Collaborate with Revit

(RWO03):
Acquire Coordinates



Link Civil 3D Topography in Revit

Civil 3D to Revit

= To streamline the process of developing, using, and
sharing topography data for a project, Revit
supports interoperability workflows with Civil 3D

= When a civil engineer creates topography data for a
project and you want to reference it for a building
model, you can link the topography to Revit

TRANSFER YOUR TOPOGRAPHY

B
WITH B 350
> 4

~ UTODESK DESKTOR COMNICTOR

q -
~ IR

FROM CIVIL 3D TO REVIT

= For this workflow you need following
products/services:

= Civil 3D
= BIM 360 Docs

= Autodesk Desktop Connector
= Revit

——




Link Civil 3D Topography in Revit

The civil engineer uses Civil 3D to do the following:

= Develop the topography

Layer *=v @

LLLLLLL

[=1[Top][2D Wireframe]

= Publish surfaces to a BIM 360 project:

= Open the drawing with required
topography

= Collaborate tab > Publish surfaces
= Select a surface to export
= Specify the output file o

= Publish the existing surface for further ST Sample ciD
use in Revit or BIM 360 T oo

: TOOLSPACE
[

— Specify surfaces to be published:

= () (8] Surfaces

(5 [] AIW_Existing_Ground

4

Prospector

El@ Surfaces
- % Civil 3 Autodesk Civil 3D 2020 @ () AW Existing_Ground
[ ite-
Modify  Analyze View Manage Output Survey Rail Transparent InfraWorks Collaborate Help A - @ e

ey

lil--'_.: Alignments

Pick from drawing
Spedify output file:
BIM 360://Project/Mount Abu/Project Files/C3D Topography/

Shared DWG  Publish Surfaces Sites

Views Compare ----- @B Catchments

Share Compare Publish Elﬂﬂ Pipe Networks

[ OK ][ Cancel H Help ]

4




Link Civil 3D Topography in Revit

What to do in BIM360 Docs

—~ Open yOur B”Vl 360 prOjeCt & Open the autopesk eiv 360 | N Vount Abu -
Document Management module : Document Management

= QOpen the directory with the published topography N

= Open the shared DWG file <9 s

= As for all documents in BIM 360 you can:
= Create mark-ups
= View properties
= Compare different versions
= Section 3D drawing/model
= Efc...




Link Civil 3D Topography in Revit

What to do in Revit

= Start Revit and go to the Insert tab BRI = = oA N | P55

Architecture  Structure  Steel Systems  Insert  Annotate nalyz

. . %%;ﬁﬂ@@@@@ﬁi
= Llnk > Llnk Topography Hiediy Fll-ler\'..rll(t LIIFan é': Toplc;igan;phy MDWka D'I glo:ic ondT L k

Select = [

Link Topography
Links existing topography to the current Revit model.

= Pick up the topography in BIM 360 project ——

B e Mount Abu
1 Li n k th e Ch Ose n to pog ra p h y [ Mount Abu [ Project Files [ 3D Topography
| e Name A Version Modified Date

= Close the Differing Coordinate Systems R

warning, Revit will assign the coordinates  Ditering Coordinate Syie ]
automatically, usually using “Center-to-Center” || mehost model and the link do not share the

same coordinate system. The link's World
coordinates will be aligned with this project’s

= |Important - For the other workflows do not Stwved courdinstes
Warning

i n Se rt/ I i n k CAD d raWi n g O r Rev it l I lOd e I ! By Imported objects located a large distance from the model might not display
. " . . . . properly. The "Center-to-Center” option will be used.
Shared Coordinates" when linking first time! . — |

2@+ + |5




Link Civil 3D Topography in Revit

Acquire the coordinates from Civil 3D topography or a DWG

= Following steps showing acquiring coordinates = gesasse=vonsomna:
are valid for any C3D topography (via BIM360) |5 %?I‘Q % ‘@ 'J @@@ ttttt @Tz 39 D 'EW“ Lgf:}s
Or DWG fileS select = S D v Load fromL ibrary
Properties X [A site X 2 (30)
FFFFFFFF i
= When you want to link a Civil 3D DWG file —
directly, make sure to set the
PROXYGRAPHICS=1 in Civil 3D o e |
= Go to a Floor Plan (Site Plan recommended) = R
= Zoom All rym.

lllll
LLLLL

= Now you can see the linked topography



Assign Coordinates in Revit

Display the survey point

= (o to any floor plan
site plan recommended

= Open “Visibility and Graphic Display*
dialog

= Display survey point 2\
= Display project base point (optiona

= Revit internal origin, project base
point and survey point are
at the starting of a project all situated in the
same place (0,0,0)

Autodesk Revit 2020 - RW1 - Assign coordinate system in Revit - Floor Plan: Site

REcHG - R-#-Q2-FO0A -0 18-+

ZICHN  Architecture  Structure  Steel  Systems Insert Annotate  Analyze Massing & Site  Collaborate  View Manage Add-Ins  Quantification  Site Designer  BIM Interoperability Tools

% @ E’* Object Styles E‘é Project Parameters t“é Transfer Project Standards EE Structural Settings ~ % @ Location
3 sh P Y P MEP - ) - i .
Modify| Materials n Snaps ,g Shared Parameters Ea urge Unused EE EP Settings Additional _ L_, Coordinates Design
l"ﬁ Project Information (E Global Parameters ‘% Project Units CB Panel Schedule Templates ~  Settings @ Position ~ Options Main Model v
Select = Settings Project Location Design Options

S ‘é Manage Images

Links :Q: Starting View

Phasing Selection

Properties X  Project Browser - RW1 - Assign coordin... X [ Site X
=10 Views (all)
E —J - Floor Plans
@ Floor Plan
Level 1
Level 2 O
Floor Plan: Site | B8 Edit Type Site :
Graphics —| - Ceiling Plans
- - Level 2
Scale Value 1 100 . - .
=} Elevations (Building Elevation)
Display Model Normal East
Detail Level Coarse North
Parts Visibility Show Original South
Visibility/Graphics... i West

Graphic Display O...

Orientation
Wall Join Display  Clean all wall joins
Discipline Architectural
Show Hidden Lines By Discipline
Color Scheme Loc... Background
Color Scheme <none>
System Color Sche... Edit...
Default Analysis D... None
Sun Path O
Underlay
Range: Base Level None
Range: Top Leve Unbounded
Underlay Orientati.... Look down
Extents
Crop View O
Crop Region Visible []
Annotation Crop  []
View Range Edit...
»‘\‘,-:v&,k ated Leve Le :c.
Scope Box None
Depth Clipping _Nodip __J
Identity Data
View Template <None>
View Name Site
Dependency Independent
Title on Sheet
Referencing
Referencing Deta
Phasing
Phase Filter Show All
Phase New Construction

Properties help

Project North o

Apply

B Legends
™ Schedules/Quantities (all)
Sheets (all)

+ & Families
4 [@ Groups

&8 Revit Links

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

1:10 % GME> 0 RAIE <
G

) @ﬂ

« 08 R danielmoralt..~ W (@) -

= B 3

Inquiry Macros Visual Programming

i AF & (h N O Yo

('CU Dynamo Dynamo
' Player

q



Link Civil 3D Topography in Revit
Moving topography

*Drag or Move the linked topography to the  gcese-c=voraomna:

ZIC8N Architecture  Structure  Steel Systems Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage Add-Ins  Modify | Topography Links @~

" " R BedE -QR-o-8 - 0A G- O 8-+ Autodesk Revit 2020 - Workflow_3E_start.rvt - Elevation: South
d e S I re d I O‘ atl O n th e ‘ O rn e r Of a p rO p e I | y ZIEA  Architecture  Structure  Steel  Systems Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify | Topography Links -~
% T Cope - & O  cia oo - — [ i
| | | | h - w [ I:I & L l oo — == C\CJJ
¢ . , B GAcut - ‘=8~ oo 4 v = —
= Modify !l _ ) “Tf ‘g* &= =_%T el \f\ . T
y . | Ed T B Gein- iZ & ] O LSS =
s Select v Properties  Clipboard Geometry Modify View Measure Create
Modify | Topography Links ‘ ["] Constrain  [] Disjoin Multiple
Properties X [ Site g {30} £ South X

*Drag or Move the linked topography to the

Q Elevation _
Building Elevation

[ ] F
desired location (the corner of a property S =
* Graphics A - :‘;_
] n [} n - View Scale 1:100 F :
line, etc.) in Elevation or Section e =
y . - Display Model Normal i
. Detail Level Coarse N
. Parts Visibility Show Original E :
. Visibility/Graphics Overrides | Edit... ;
. Graphic Display Options ( Edit... ; on
" Hide at scales coarser than 1:5000 S8 S
_ Discipline Architectural - 274|
- Show Hidden Lines By Discipline i
Color Scheme Location Background . T T T TT TS TT T T T TT T T T n T
Color Scheme <none> H
' Default Analysis Display Style :None H
" Reference Label H
J. Sun Path it AL 11
Extente A [ Please enj:'er a length ]
* Crop View
3 Crop Region Visible 2%
" Properties help Apply
i Project Browser - Workflow_3E_start.rvt X

S 30, Views (all)
=) Floor Plans
Level 1
Level 2
Site
(=) Ceiling Plans
Level 1
Level 2
= 3D Views
Navis
{30}
[=-- Elevations (Building Elevation)
East
North :
South ¥
West 1
Legends
= Schedules/Quantities (all)
Sheets (all)
91 Families
[@] Groups
& Revit Links

il
-



Link Civil 3D Topography in Revit
Acquire coordinates from a linked file

- Afte r yo u p OS i ti O n e d th e I i n ke d Autodesk Revit 2020 - Workflow_3E_start.rvt - Floor Plan: Site
topography/DWG at the desired location, | Maage | | Moty | Topogapry Lk | GO

we can start with acquiring coordinates Ty 8 e =
R T
= Go to Manage > Project Location > [ pubish Conrdnats
Coordinates > Acquire Coordinates T 12 Specty Coontnstes t P
. . : /// BReportSharedCoordinates
= Select the linked file i

Survey Pont - Internal

= Now the coordinates from the linked file |

|

|
| | Shared Site:
are acquired i | U ENV 0.0000
q o ase Pomt : A\ eV 0.0000

NIS 27111821875
1 EW 272997 5312 |
O—- | Eev 2780000 .

= Select the Project Base Point and check
the modified coordinate values

ngle to True North 0.00° g)

= The Survey Point should still be at 0,0,0



Link Civil 3D Topography in Revit

Removing the link

= |In order to control the successful acquiring N—
of coordinates, remove the linked
topography/DWG and re-link it;

= Manage > Manage Links >
Topography/CAD Formats

= Select the linked file and remove it

= This step is not only for checking, it is
necessary for the DWG in order to get the

file linked by newly created Shared L N — ) _—

Coordinates - '




Link Civil 3D Topography in Revit

Re-linking by Shared Coordinates

= Now re-link the topography/DWG REecHG-®-=-@ &
File Architecture  Structure  Steel
= For the topography the linking will be handled [ [RRR ) R
automatically by Revit Modiy) Lk Lokl Lok | ook
Select =
= For the DWG use the option "Auto — by Shared |rexceer:
Coordinates” “.
= Finally the re-linked file should appear at the
correct location, specified in the previous steps
without any manual adjusting
|
ctore. pars G ]
——y T e
Import units: [Auho-Dehect v || 1.000000 | [V] Orient to View
Tools v [ Correct lines that are siightly off axis | Open | Cancel




Link Civil 3D Topography in Revit

Reloading a new version of topography

The BIM 360 workflow
greatly improves the workflow for i
topography transfer from civil X
engineers to architects

You can make changes in Civil 3D
and then upload as described in the
previous process to BIM 360

In Revit, just use reload or reload
from and link topography again

ate  Analyze Massing & Site  Collaborate

View Manage Add-Ins  Site Designer  Modify &~

Main Model

Project Location Design Options Manage Proj Phasing Selection
f"'d_,p-'—"\
_/d-ﬂfﬂ \'"
—
//""
.
Manage Links
— |
[Revit |1FC | CAD Formats | DWF Markups | Point Cloud$ | Topography |
I
Link Name Status Size Saved Path Path Type

RW3 - Acquire Coordinates in Revit Loaded




Link Civil 3D Topography in Revit

What method assures the best representation?

= Using the Link Topography workflow
assures an accurate representation of
topography from Civil 3D surfaces in Reuvit.
Compare the results of the same surface
data in the images below:

o
y

Modify

roperties

R

Cdiyg - g 2 ‘./' YA o7 Is‘:l §CJ © ¥ PUIOUESK REVITZULY - NOLTOT Resdie VETSIon - Fiaygrouna ora MEtogeT v - 50 View: (9U] ’I,'y[\f @ keyword or phrase Ib‘d E a l Fernando_Revit ~ w w ~
Architecture  Structure  Steel  Systems Insert Annotate Analyze Massing & Site  Collaborate View Manage Add-Ins  Modify | Topography (e 2

S BE&blzT 0= 1[G B %]
%) kel 12 oo = | b

| U
=
Select v Properties Clipboard Geometry
Modify | Topography

Architecture  Structure  Steel Systems Insert Annotate Analyze Massing & Site  Collaborate View Manage Add-Ins Modify | Topography &~

N K ¥ cope - ‘E] E&Di le ::oiog uij ; [COOJ' E}

Modify| [TH D Fw- &=&- + On = 0O y-= 028 4t
'I - W Gon - & ‘3’ Q O _!lh 2 H xR & ’* ) IL_;‘O Surface
Select + Properties Clipboard Geometry Modify View Measure Create Surface
Modify | Topography
broperties X Level 2 [7) site 2 (3D} X
Topography (1) 'l
Materials and Finishes )
R — IMPORT METHODS
Dimensions &
Projected Area 83432415 m" = / \
Surface Area 84217.564 m* &\?\ﬁ\\\\\\‘\
identity Data b g N, NRR

Properties help

Project Browser - Playground old methode.rvt X
5@ Views (all)
—| - Structural Plans
Level 1 .
Level 1 - Analytical "‘\
Level 2
Level 2 - Analytical
Site
— 3D Views
Analytical Model
(3D}
—| - Elevations (Building Elevation)
East
North
South
West
= Legends

B Schedules/Quantities (all)
B crnce soan

1

v 1:00 B «cGBREGY o BHEGE « m

/ \N
Image
Comments =~ &
Name r \\ | T “N
Mark - i‘) \ /,/ > -
I N

K ¥ cope -
D At~ &
7 W GJom » Z

WO & 0 o oo N SF o-g
(O ) == = - Edit Toggle Reveal Hidden
* ‘i‘ Q ( ) _Atlh =) 2 X & ’* |‘3 @  Surface Elements Mode

(aln)

level 1
level 1
level 2
level 2

Al ite

ews

BD}
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orth
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nalytical Model
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1) E:
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Modify]
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Link Civil 3D Topography in Revit

Video — Link

ing Civil 3D topography in Revit using BIM 360

- £ Coal 30 Autodesk Civil 3 20 RW3 - Acquire Coordinates in Revit.dwg Type word or pheose M 2 sleanderbew. Y A @ -
: fools  Featured Apps — Geolocation
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B8 Traverse - &% Grading - B Comdor = J% PipeNetwork =+ @ Section Views - 5 ¢ « [5] - [X\ Stretch [Scale 35 Amay « & Properties To £, F T T, Match Layer y

Palettes v Create Ground Data ~ Create Design ~ Profile & Section Views Draw ~ Moddy ~ Layers ~ Clipboard
Start RW32 - Acquire Coordinates in Revit* X +
TOOLSPACE [=WTop]|2D Wireframe)
L3 ¥ H
Active Craning View -
= [ RW3 - Acquire Coordinates i...
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@] Point Groups
4- (% Surfaces
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U

Feature Lines
Sites

Catchments

1

s

Ee

=

Pipe Networks
Pressure Networks
Corridors

Assemblies

+

¥ P33
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Survey

E12§

| View Frame Groups
= [E] Data Shorteuts []

Surfaces
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o

b
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]

View Frame Groups
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Collaborate with Revit

(RWO04):
Publish Coordinates from Revit to DWG



Publish Coordinates from Revit to DWG

Get your models and drawings files easily connected to Revit

= When you publish shared coordinates from pgg=e= =

a host model to a link, the linked
model/drawing is updated with the new
coordinates

= The host model's True North and shared
origin are recorded Iin the linked
model/drawing, based on the current
position of the linked instance

= This location is now applied in both host
model and the link. More than one position
of the link can be created and used

= The shared coordinates establish the
relative locations of the models or
drawings

eeeeeee

Graphi
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Visibility/Graphics...
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llllllllll

all Join Display  Clean all wall joins
Discipline  Archi

Annotation Crop

_Nodip |
Identity Data

Title on Sheet

ooooooooooooo

@
o Som o

+ Families

+
1 2BPDAM: = &
FOTYERmy

A OA G-QF 0 a Autodesk Revit 2020 - RW04 - Publish Coordinates from Revit to DWG - Floor Plan: Site
ystems Insert Annotate  Anal View Manage Add-Ins Quantificati Tools odfy (R4
f‘] @ [.21 @ @ E = 5
UFE&;@@EE @0@&51&[0 '>
I
eeeeeee
Build Circulation ~ Model
rowser 04 [ site
iews (all ]
mmmmmmmmm
Level
Level
Site
Ceiling Plans
View:
nnnnnnnnnnnnnnnnnnnnnnnnnnnnn
nds
I

Opening

eeeeeeeeeeeeeeeeee

DDDDD

AR T (b O Po




Publish Coordinates from Revit to DWG

Bring the DWG to correct place in the Revit model

This workflow continues from RWO01 as th
Revit model has been already relocated by
specifying coordinates

Now we can publish the Revit model real
world coordinates to AutoCAD drawing (or
another Revit model

Start with the model, used for the workflow
RWO01

Link DWG into Revit using “Center to
Center”

Align/rotate/move to the right position

REecHG-®---@2-F0A G-0FE .8

File Architecture ~ Structure  Steel

OO HE &

Systems  Insert  Annotate  Analyze

Massing & Site  Collaborate

View Manage Add-Ins Quantification

Site Designer

Autodesk Revit 2020 - RW04 - Publish Coordinates from Revit to DWG - Floor Plan: Site

BIM Interoperability Tools

Modify

| FECUEE BODANDERE BX VR
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i " N N ¥ System Grid x
Select ~ Build Circulation
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Level 2
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Show Hidden Lines By Discipline
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Color Scheme _____<none> |
System Color Sche... Edit...
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Sun Path 0
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Underlay Orientati....Look down
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Crop View O
Crop Region Visible []
Annotation Crop [}
View Range Edit..
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Scope Box None
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Identity Data x
View Template <None>
View Name STt; WWWWWWWWWWWW
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Title on Sheet
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Phase New Construction

Properties help Apply

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.
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Publish Coordinates from Revit to DWG

Publish Coordinates

= Publish Coordinates to the DWG
> Manage tab > Project Location menu >
Coordinates > Publish Coordinates

= Click OK & save the Reuvit file

= Save — save the new position back to the
link (DWG/Revit files must be close

= Remove the link and re-link it using “Auto —
By Shared Coordinates”

= Finally the re-linked file should appear at
the correct location, specified in the
previous steps without any manual
adjusting

REcGHG - ~"-@-Q2-FO0A G-0F 8-+

Architecture  Structure
51 00

Steel Systems Insert Annotate Analyze Massing & Site

af UFE—’&;@@@E @O@Al&[@@[@@@ Eo‘“

Ranlmg Ramp Stair Model Model Model

Modify] Wall Door Window Component Column Roof Ceiling Floor Curtain Curtain Mullion
N v v Text Line Group

System Grid

Select ~ Build
Properties X Project Browser - RW04 - Publish Coord... X Ef] Site
= O Views (all)
b —] - Floor Plans
! Floor Plan v
Level 1
Level 2
Floor Plan: Site v B Edit Type Site
2 + - Ceiling Plans

Graphics

+ - Elevations (Building Elevation)

View Manage

Add-Ins  Quantification

Model

Scale Value 1 100 e
5| Legends
Display Model Normal ™ Schedules/Quantities (all)
Detail Level Coarse Sheets (all)
Parts Visibility Show Original 2 Families
Visibility/Graphics.. | Edit. | | & [@] Groups
Graphic Display O... Edit.. | &9 Revit Links
Orientation P'rdJIedVNvo.rt'h vvvv
Wall Join Display  Clean all wall joins
Discipline Architectural
Show Hidden Lines By Discipline
Color Scheme Loc... Background
Color Scheme __<none>
System Color Sche... Edit...
Default Analysis D... Nor‘\e‘ -
Sun Path 0
Underlay L
Range: Base Level None
Range: Top Leve Unbounded
Underlay Orientati....Look down
Extents L
Crop View O
Crop Region Visible []
Annotation Crop  []
View Range Edit...
. R
Scope Box None
Depth Clipping - ‘Nq ;Iip _
Identity Data &
View Template <None> |
View Name Site
Dependency Independent
Title on Sheet
Referencing Sheet
Referencing Deta
Phasing A
Phase Filter Show All
Phase New Construction
| - -
Properties help Apply 1:100 Ok SME> 0 CRAIE <

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

Room Room
Separator Room

Autodesk Revit 2020 - RW04 - Publish Coordinates from Revit to DWG - Floor Plan: Site

BIM Interoperability Tools

Tag Area

Room & Area »

CNENA] o voce

Shaft Wall Vertical Dormer

« 4 R danielmoralt..~ Y@ (@ - -0 X

7 i @8 LD

Grid Set Show Ref Viewer
Plane

Datum Work Plane

Ll

wai & (h N O Yo




Publish Coordinates from Revit to DWG

Check the coordinates from the link instance

= QOpen the linked file and change the UCS
coordinate system to the Revit exported
coordinates system:

=  Select & right click the UCS icon

= (Choose > Named UCS > Revit60-
DefaultLocation

= Use Command: Plan > current UCS

= Home tab > Ultilities menu > ID Point and
pick a known geographical point to make
sure the workflow was correctly done

= Nothing is moved/rotated in AutoCAD

heci -HE-EXA %+ HlE 0=



Publish Coordinates from Revit to DWG

Video — Publish coordinates from Revit to a linked DWG

»‘ 6] E E‘ E‘i s o Autodesk AutoCAD 2020 RWO04 - Publish Coordinates from Rewvit to DWG.dwg » Type a keyword or phrose M ! danielmoralt..~ A - 0 v
(B
0 Raster Tools xpress Tools  Vault Featured Apps BIM 360 o -

Vatrne
1etru

Home nsert  Annotate P

arametric  View Manage Output Add-ins Collaborate
<+ Move ( Rotate % - / A ‘\‘/. i » ¢ § - » [ eylayer - \‘1* 84 oo NH Ii" B h b
- [___ - = . g &7 > )

- - .- 03 - 1
. : Py Co 1\ Mirror " : . ‘ r % Bylayer ~ [
Line Polyline Circle ' & A Text Dimension \ Match s Group 2 Measure % Paste ‘ Base Select

Y 4 v fl Stretch — | Scale 5 = . ] Properties ﬁ z ﬁ oo :”g * Properties = —————Bylayer ~ [u x E v X Mode

Draw ~ Modify « Annotation v Layers » Properties « ¥ Groups ~ Utilities Clipboard View v ¥ Touch

Start RWO4 - Publish Coor...s from Revit to DWG* X +

! PROPERTIES [=][Top) 2D Wireframe]

No selection > > 9 N

General v
Color W Bylayer W n E
Layer 0

Linetype . - ByLayer
Linetype scale 1.0000
Lineweight e ByLayer

Transparency Bylayer
Thickness 0.0000

3D Visualization

Matenal Bylayer

Plot style
Plot style

Plot style table

Plot table attached to

Plot table type

View

Center X

Center Y

Center Z

Height
Width

Misc
Annotation scale 11
UCS icon On Yes
UCS icon at ongin Yes

B X /“ "~ Type a command -

Model  Layout yout2  + 108.2031, -65.3348,0.0000 MODEL (i i v || & v <« A - R X A - B -+ @ o=




Collaborate with Revit

Prepare your Revit Model for Exporting Out



Prepare your Revit Model for Exporting Out

Custom 3D view for exporting

= We recommend to create a 3D view and name it with &2, Views al)
"navis" prefix as Navisworks and InfraWorks look for =
a Revit view with this name to import first  level2

= In this view you can control the elements transferred =~ & 9"t
turning off the categories that are not needed

. Level 2
| [3 ..... 3[)Views
= That way you can easily control the LOD (level of .
detail) of your exported model and facilitate the | s B Hemtind
import of Revit models in other applications . East



Prepare your Revit Model for Exporting Out

Export to Navisworks

m Revit>ExpOrt>NWC REcecHG - R-a- @ 2-FO0A ©-0
- Architecture  Structure  Steel Systems Insert  Annotat
M Navisworks Options Editor - Revit X
= Navisworks Options > File Readers  Generd Conver consicton pats 1)
4 Model Convert element Ids [
= T‘?::"’—‘ Convert element parameters  All v
= Revit > Coordinates o st

Convert linked CAD fomats ]
Convert linked files [

= You have following options at Convert room s trbute.
Coordinates: ——
» Project internal T —

Export room geometry

= Shared Faceting Factor |1

Try and find missing materials [

= We usually recommend to work with
the default option “Shared” (which Dot
means Shared Coordinates) S e —




Prepare your Revit Model for Exporting Out

Export to IFC

= Revit > Export > IFC ROcHG - %-F-Q2-FO0A G0
| Architecture  Structure  Steel Systems Insert  Annotate

- MOdIfy Setup > General &E Creates exchange files and sets options.

 Export IFC '
= You have following options at Project oty Setup =
O ri g i n : Zi:&i‘i;s?:osr::: t?on View 2.0 Setup> General | Additional Content | Property Sets | Level of Detail | Advanced

<[FC2x3 Coordination View Setup> TR IFC 2x3 Coordination View 2.0
<IFC2x3 GSA Concept Design BIM 2010 Setup> ‘

= Current shared coordinates AFCE3 Basic M Hancover ViewSetp> | e

<[FC2x2 Coordination View Setup>
<IFC2x2 Singapore BCA e-Plan Check Setup>

B I - <IFC2x3 COBie 2.4 Design Deliverable Setup> Phase to export Default phase to export
I e S u rvey p O I n <IFC4 Reference View Setup>
<IFC4 Design Transfer View Setup> Space boundaries None

- P rOj e Ct b a S e p O i n t Project Crigin Current shared cooites
. ' ] Split Walls, Columns, Ducts by Level
= Internal coordinates '

Include Steel Elements

Project Address...

= We usually recommend to work with EEEE —
the default option “Current shared
coordinates”




Streamline data sharing Civil 3D, Revit & InfraWorks

What you’ll learn today

Coordinate System ? Collaborate with Civil 3D Collaborate with Revit Collaborate with
Infraworks

* Coordinate System: What? Why? * Infraworks to Civil 3D «  Workflows: Assign, Acquire, «  Workflows: Revit, FBX, IFC &
How? * Reuvit to Civil 3D Publish Coordinates to Revit Civil 3D to Infraworks
» Understand Coordinate System * Prepare your Revit Model for * Prepare your Infraworks Model

for Products exporting out for exporting out




Collaborate with Infraworks

Import AEC Model to InfraWorks



Import AEC Model to InfraWorks

Best practices to bring your AEC model into InfraWorks

Buildings Data Infrastructure Data

*"IWO04-Import IMX to InfraWorks
= ocal Import [&

*"[WO05-Import LandXML to InfraWorks

=  |WO1-Import Revit models (*.rvt)
= Cloud Import|&

= Local |mp0rt on x| ocal |mport o
= IW02-Import IFC models (*.ifc) ="IWO06-Import Civil 3D Drawing to
InfraWorks

= Cloud Import|

*| ocal Import [=

= [WO3-Import 3D model (.fbx)
= Local Import [=




Collaborate with Infraworks

(IWO01):
Import Revit Model into InfraWorks



Import Revit Model into InfraWorks

To set data import option to local or cloud

= By default, file conversion is processed in
the cloud for many file formats

= Use Application Options to enable/disable [ * wexenore
Iocal Import fOr Su ppOrted formats ,_ lc:::eigr::aon nfra orkssu‘;:portsbothcloud(default)andbcaldataimportforsomeﬁleformats.Touselocaldabimport.you need to have

Modsel Generation er Autodesk products installed in your machine. Please check below that apply.
Unit Configuration

. o i 3D Graphics
1 Data Navisworks based Local Import (Navisworks Manage 2020, or Simulate 2020 &4-bit required)
= Cloud import [ T —

Point Cloud

Supportad File Formats
AutoCAD DWG (3D Objects), Autodesk Revit, DGN 3D Model, IFC, SketchUp

= Local import [

= For Local import it is required to have
installed same version of Navisworks
Manage or Simulate as InfraWorks

* Click (&) > {o»> Data Import > Checkmark
Navisworks based Local Import




Import Revit Model into InfraWorks

Import your Revit (*.rvt) file with local import

DATA SOURCES g1 X

= Check Naviswork based Local import
option

Group by: | Feature Type¥ | Show: | All

- @@ XE 4

ame “ Source Type Status  Date Loaded

= |n InfraWorks, C|iCk‘ >822 > 453

= On the Data Sources panel
= Click (Add File Data Source) | 1
= Click Autodesk Revit
= Open the Revit model file

= |If prompted, in the Data Import dialog, click
Send

¥ A Hide Details

Data Source Details

Name: IWO1 - Import Revit model to Infraworks

Description: <Empty>

= When the model is finished processing, it
displays under Buildings in the data

Source type: 3D Model
Connection string: 3D, Revit and InfraWorks/IW01 - Import Revit model to Infraworks.rvt
Coordinate system: | XY-IFT (Arbitrary X-Y Coordinates (IFest))

Date loaded: <Empty>

sources list



Import Revit Model into InfraWorks

Configure your Revit (*.rvt) file with local import

= Double-click the data source to configure it g

= (Geolocation Tab: InfraWorks transforms
project coordinates to geographical
coordinates

= Define the insertion point: choose the
desired coordinates system and change
coordinates to X=0, Y=0, Z=0

= 3D Model tab: check the geometry is
correctly displayed. You may want to use
LOD for big models. Close & Refresh

= Zoom In: Big models geometry elements
becomes less reliable and less accurate so
distortion may be seen



Import Revit Model into InfraWorks

Import your Revit (*.rvt) file with cloud import

= Disable Navisworks based Local import
option

= Repeat the same process as before to
import the Revit model

I Autodesk InfraWorks - Mount_Abu,Rajashtan,India

a Daniel Moral Trigueros

&

IS

7
=

surface Layers

(]

Model Explorer

Properties

Model Properties

Style Palette

7]

Proposals

10.0

Style Rules.

Point Cloud Terrain

Point Cloud Modeling

Point Cloud Themes

Linear Feature Extract...

Export Point Cloud EX...

Point Cloud Image Lo...

DATA SOURCES

Group by: | Festure Type¥ | Show: | All A

-8 &l o X e

Name
w [ Buildings
B Building
v D Coverage Areas
E Site_Boundary
7] Ground Imagery
B Bing Map Image
¥ [ Mount_Abu_Rail_Data
[£] Mount_aAbu_Rail_Data
¥ [ JRoads
[Z] M_Export - ROADS
5] Road
v E]Terra'ln
[E] Project_MA - Surfaces
[E] stte - Surfaces
v B Water Areas
B Stream_Pond_River

4

Datz Source Details

Name: <Empty>
Description: <Empty>
Source type: <Empty>

Connection string: | <Empty=
Coordinate system: | <Empty=

Date loaded: <Empty>

“ Source Type Status

Vector Imported
Vector Imported
Raster Importad
Vector Imported

Autodesk IMX Imported
Vector Imported

LandXML Importad
LandXML Importad

Vector Imported

Hide Details




Import Revit Model into InfraWorks

Configure your Revit (*.rvt) file with cloud import

= Double-click the data source to configure It g

= (eolocation Tab: warning pops-up.
InfraWorks does not read the project
coordinates system from Reuvit

= Define insertion point: choose the desired
coordinates system & change coordinates
to X=0, Y=0, Z=0. Offset using the
coordinates of the Revit Internal Origin

= 3D Model tab: check the geometry is
correctly displayed. Close & Refresh

= The model displays in the correct place
and geometry Is correct




Collaborate with Infraworks

(IWO02):
Import I[FC Model into InfraWorks



Import IFC Model into InfraWWorks

Import your IFC model with cloud Import

= Export IFC file from Revit

Q Daniel Moral Trigueros
o]

= Use cloud import || to bring IFC models
into InfraWorks. Click (&) > €0 > Data
Import > Navisworks based Local Import
should be unchecked

Export Point Cloud EX...

A

Point Cloud Image Lo T

= In InfraWorks, C|ICk. >8> &3

= On the Data Sources panel
= Click (Add File Data Source) | 1
= Click IFC
= Open the IFC file

Point Cloud Modeling

= When the model is finished processing, |

displays under Building in the data sources s

— O
@ DATA SOURCES g X
Group by: \ Feature Type¥ \ Show: \ All v \
-y = 73 . 1 :
WO - L @l o X @4 oo
Name “ Source Type Status Date Loaded
¥ EJBuildings
(] Building Vector Imported Wed Mar 6 20
E Iw01 - Import Revit mod... 3D Model i -
¥ [ JCoverage Areas
(5] site_Boundary Vector Imported Fri Jun 14 201
¥ EJGround Imagery
(5] Bing Map Image Raster Imported Fri Jun 14 201
P~ [EJMount_Abu_Rail_Data
o ';,;,:'v'%r-’."’-"‘*'v Mount_Abu_Rail_Data Vector Imported Tue Mar 19 2(
i v FJRoads
(5] IM_Export - ROADS Autodesk IMX Imported Fri Jun 14 201
[5] Road Vector Imported Fri Jun 14 201
v [JTerrain
(5] Project_MA - Surfaces LandXML Imported Wed Mar 6 20
[5] site - Surfaces LandXML Imported Fri Jun 14 201
v [FJwater Areas
[5] stream_Pond_River Vector Imported Wed Mar 6 20
4 »
¥ A Hide Details

Data Source Details

Name: 'IW01 - Import Revit model to Infraworks
Description: | <Empty>
Source type: 13D Model

Connection string:  3Works/IW01 - Import Revit model to Infraworks.ifc

Coordinate system: ' XY-M (Arbitrary X-Y Coordinates (Meters))

Date loaded: | <Empty>




Import IFC Model into InfraWWorks

Configure your IFC model with cloud Import

. DO U b I e-CI iCk th e d ata SO u rce tO CO nfi g u re it I Autodesk InfraWorks - Mount_Abu,Rajashtan,India_dmt 0 %
BN oo Mol Trigueros %

= (Geolocation Tab: warning pops-up. :
InfraWorks Is not able to transform

Data Sources Point Cloud Themes

Al g

coordinates system from IFC W

Surface Layers Linear Feature Extract...

C L e st e T T S

Model Explorer Export Point Cloud EX... e e ______,_.___--a—-_,__n——;jJ—m

= Define insertion point: choose the desired EECESEE
coordinates system and change
coordinates to X=0, Y=0, Z=0 (*)

Model Properties

tttttttttttt

———

ooooooooooo
p———

= 3D Model tab: check the geometry. The ,_ et
graphical representation of elements B i
becomes not reliable and not accurate
because the model is significantly far away s
the origin 0,0,0 (*) iy

Thumbnail

Point Cloud Modeling

g | T
; - #__é:‘,p: k(] SR
e - PR 1Lk
= S 1)
. ’ - E ot S
R - ] s
) - T e
1 ~ ™ G I R
e — k-/_\'.'g'f‘""' : A I L
J ) . K =
. " - R



Import IFC Model into InfraWWorks

Do it correctly

= Make a CO py Of *.th mOdeI & Change I Autodesk InfraWorks - Mount_Abu,Rajashtan,India_dmt — = X
survey point coordinates values to 0,0,0
and bring it back to same position clipped

= Repeat process to export and import IFC

= |gnore geolocation warnings. Choose the
desired coordinates system and change
coordinates to X=0, Y=0, Z=0. Offset using
the coordinates of the survey point as we
chose same, while exporting IFC

= 3D Model tab: check the geometry is
correctly displayed. Close & Refresh

= The model displays in the correct place e
and geometry iS CorreCt ><za’73301.415477Y:2712066.9909132:273.9996'71_1}15' ._” 2 ;




Collaborate with Infraworks

(IWO03):
Import FBX Model into InfraWorks



Import FBX Model into InfraWorks

Import your 3D model with local import

= Export FBX file from Revit. You may want
to use LOD for big models

= |n InfraWorks, click‘ >822 >4

= On the Data Sources panel
= Click (Add File Data Source) | 1
= Click 3D Model
= Open the FBX file

= When the model is finished processing, it
displays under <No Feature Type> in the
data sources list

= |t will be always using local import =] to
bring 3D models into Infra\Works

Hide Details

Name: \ IW01-ImportRevitmodeltoInfraworks-3DView-Navis_export

Description: ‘ <Empty>

Source type: | 3D Model

Connection string: | Works/TW01-ImportRevitmodeltolInfraviorks-3DViewi-Navis_export.fbx |

Coordinate system: | XY-IFT (Arbitrary X-Y Coordinates (IFest))

Date loaded: ‘ <Empty>




Import FBX Model into InfraWorks

Configure your 3D model with local import

= Double-click the data source to configure it g

= Some warnings pop-up. InfraWorks does
not read the project coordinates system
from the .fbx exported from Revit

= Change Type to Buildings

= (Geolocation Tab: define insertion point.
Choose the desired coordinates system
and change coordinates to X=0, Y=0, Z=0.
Offset using the coordinates of the Revit
Internal Origin

= 3D Model tab: check the geometry is
correctly displayed. You may want to use
LOD for big models. Close & Refresh




Import FBX Model into InfraWorks

Open Data model (*.ifc) / Revit model (*.rvt) / 3D model (*.fbx)

1 Autodesk InfraWorks - Mount_Abu,Rajashtan,India_dmt - O X

Data Sources

\\

Surface Layers

Model Explorer

Auto Positioning v <« X B

Bls

Model Properties

(With Local Import)

Offset Positioning <& <
Reduced File Size </

X
Fast Process </ X
Texture Import X <7
4
4

]

s ¢

Style Rules

Point Cloud Terrain

7
/
/
X
X

Point Cloud Themes

Linear Feature Extract...

-
Export Point Cloud EX...

=

Point Cloud Image Lo...

BIM Exchange </
Extension

Prevent Data lost X

62.21274.000272m **
[ o8 S :~. 5




Collaborate with Infraworks

(IWO04):
IMX to InfraWorks



Data Import in InfraWorks

InfraWorks displays the added data as InfraWorks features

Autodesk Civil 3D drawing object becomes... InfraWorks model object Notes
TIN surfaces Terrain surfaces *Each surface is listed in the Data Sources panel.

°CIick‘ > §&% *g to adjust the order of terrain surface layers.
Alignments and profiles Component roads (horizontal and vertical geometry) *Only Centerline type alignments can be brought in as component roads.

*A single profile is used for each component road, based upon the first finished ground profile that
was created in the Autodesk Civil 3D drawing. Use Profile View to review the profile geometry.
*Best fit profile entities are not brought into InfraWorks.

Corridors and Corridor surfaces Coverages and terrain surfaces *We recommended that you create one or more corridor surfaces in Autodesk Civil 3D to bring
into InfraWorks.
*Autodesk Civil 3D link styles are used to create coverages in InfraWorks which show the materials of
the corridor. The coverages allow you to stylize the different corridor components like pavement.
Important: Coverage areas are only created in InfraWorks for link codes within a code set style that
have a render material assigned inAutodesk Civil 3D. The link styles are used as TAG expressions
when imported to InfraWorks.

Pipe Networks Pipelines with inlets and manholes or pipeline connectors °If a structure in the Autodesk Civil 3D drawing has a Drainage Utility Type specified and is using the
new default parts catalog with component object parts for pipeline connectors, InfraWorkswill use
the same component object parts. When there is no match of pipeline connector parts, generic
objects are displayed.


https://knowledge.autodesk.com/support/infraworks/learn-explore/caas/CloudHelp/cloudhelp/ENU/InfraWorks-RoadsandHighways/files/GUID-16C4D630-A4C4-4BC6-9365-DDEC802FE4F9-htm.html

IMX to InfraWorks

Just import & configure

= Use Command: IMX_Export or use
InfraWorks>Export IMX from Civil 3D g B AR B

*"InfraWorks > Data Sources panel > Add File
Data Source > Click Autodesk IMX —

=Select the feature classes to import "Each e BOXea %
feature class will appear under its respective T e T T —

¥ [ Buildings

e View _Manage = Output  Survey

Export

Monterey Bay DWG - AIW_Existing_Ground

Monterey Bay DWG - AIW_Existing_Transportation
Monterey Bay DWG - AIW_Proposed_Ground
Monterey Bay DWG-PIPES

Monterey Bay DWG - DRAINAGE PIPE CONNECTOR

Monterey Bay DWG.dwg
“ JMonterey Bay DWG-ROADS
‘g
g
(g
g
(g

RERRE

category in the Data Sources list. For example, | . Gues s o ez
SeleCt Pipelines if yOu are importing [Cjimagery  Raster Imported Mon Mar 23 2015
5 terey... Civil30Dwg Configured
. . . T OK Cancel
importing a surface. el

¥ [ Pipeline Conn...
Fi Monterey... Civil3DDwg Configured
pipes, Roads if you are importing a T
corridor/Alignment, or Terrain if you are c e T M e os
"Design Road/Alignment will come as a
centerline & Surface as Terrain (no grading) Dot Ve

£ Collapse All
on Mar 23 2015
on Mar 23 2015
on Mar 23 2015

Mon
M
M
M



https://knowledge.autodesk.com/support/infraworks/learn-explore/caas/CloudHelp/cloudhelp/ENU/InfraWorks-UserHelp/files/GUID-B0CE8D89-F17D-422F-8EF9-DA17838F3CE4-htm.html

‘ l/"’l.

InfraWorks Workflow-05 (IW05):
Land XML to InfraWorks

\‘ ‘



Land XML to InfraWorks

Export from Civil 3D

View Manage Output Survey Autodesk360 Help Add-ins

=Qutput tab > Export panel > Export
to Land XML

=Select Civil 3D objects to be included like S
Point Groups, Surfaces, Alignments and
Profiles, Sites, Pipe Networks, Pressure
Networks, Corridors

*Specify LandXML version- 1.0, 1.1 or 1.2 >

Export IMX Exportto xport Civil 3D

LandXML  Drawing  [® Exportto HECRAS " |

Export

wil Expres A. Export to LandXML

= Page Setup Manager ﬁ @ V; < Export Points B | Sgedfvmobjed[__s‘ to b;exporbed:
- T e
) ) ’ — C .~ . o] iy ki3 ¥
. View Details i B Transfer Points e |

=8 (€] [¥] Point Groups
 [¢] @ _all Points

~- @ Surfaces

~- "3 [v] Alignments
@ Sites

ﬁﬂ Pipe Networks
ﬁlﬂ Pressure Networks
-- Corridors

Click OK

E[:\s Pick from drawing




Land XML to InfraWorks

Just Import & Configure

*|InfraWorks Module > Manage your Model > Data
Sources

*Add Data Source > LandXML > Select file S | T s

.SeIeCt CIVII ObJeCt Wlthln the LandXML flle 2:(;”;““ 'c°"'s?§?ijﬁffiss1§§§$32§§l’§?cu ;D;| - =
. ] Gy DGN 3D Model § Corridor-STHE0-MPHS5-Secti g%:ﬁﬁ&
=Surfaces will fall under the Terrain group & ' SO o
Corridors and Alignments will fall under the Roads oW

group

=Design road will not come but the alignment will
come as centerline

(1] Corridor-STHE0MPHSS-Section2a-ROADS

v D'Er?:v

(1] Corridor-STHE0-MPHSS-Section2a - STHE0-Section2A - Corridor - TOP
(5 oo oo o & Lo~

4
¥ A
Data Source Details ¥ A Hide Details
Name: Data Source Details
Description: Name: pl
Source type: E Letiiet
Source type: LandXML

Connection string:

Connection string:  /scottm/Desktop/Corridor-STH60-MPHS55-Section2a. xml
Coordinate system: (Wisconsin County Systems: Richland County, US Foot)

«
»

Date loaded:
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InfraWorks Workflow-06 (IWO06):
Civil 3D Drawing to InfraWorks




Civil 3D Drawing to InfraWorks

Things to be mindful of...

When you bring Civil 3D alignment, profile
and corridor data into a model

= Centreline alignment and profile data
used to define the component road
with centreline

= Coverage styles to display the areas
corresponding to the corridor link
styles

= Civil 3D corridor comes Iin as corridor
surface & coverage

Note: InfraWorks uses predefined style rules
to map alignment styles to component road
styles and corridor links to coverage area
styles. These style rules are based on the
Autodesk Civil 3D alignment styles and link
styles included in the standard templates

The same corridor data brought into InfraWorks, which uses default style rules to
display the road and coverage areas



Civil 3D Drawing to InfraWorks

Things to be mindful of...

= Behaviour of Alignment and Profile Entity Types When o o s s i s o
Exchanging Data between Civil 3D and InfraWorks T B E
N—am[; — _ Description Style Label Style Render Material  Material Area Fi... Rat
. K, <No Codes> _Neo Dfspuy <non ﬁ,’; <none> ne>
» InfraWorks uses predefined style rules to style the 3 . = o= =
display of AutoCAD Civil 3D data that translates into i i = i =
" . I, SubBase NoDisplay @~ <none> &% <none> <none>
design roads and associated coverage areas o oo e Gew e
I, Footpath _No Display_Footpath no &% Flat - Polished G... <none>
K, Daylight_Fill _No Display <none> <none>  <none>
~frnl P B ol g
= InfraWorks & Civil 3D uses same material library B e

1) o Deaplay_Davight TAG ="_No Daglay_Dayight Materal s
27 Jie Daglay _Verge TAG =" o Daglay _Vverge’ Materal Ly
5 3 2o Dagplay_Fave TAG =" _No Daplay_Pave’ Materal R
Ny o Daglay_CertralReservation TAG = Ne Daplay Centralleservation’ Materal )
s ) 2o Daplay riardshouider TAG =" o Duplay rardshoulder” Mater sl R)
67 e Daglay_Sope_Lrk TAG = _MNo Daplay_Sope Lk’ MateralLe
1% 2o Daplay_Dvich TAG =" o Dagplay Dacly Materalls
2 2o Daglay_Xerd TAG = Mo Deplay_Kerd' Materal R
s 7 Jie Daglay_Feotbeth TAG =" Mo Daglay_Foopesy Materal By
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Civil 3D Drawing to InfraWorks
Open drawing in Civil 3D

= Open Drawing “New_ Road” & Make
sure drawing Is assigned with
Projected CS - UTM84-43N —

9 New Road
¢ Points

=Confirm Alignments, Corridors & [ oo

#@" AIW_Existing_Ground

Corridors Surfaces names are proper s

Prospector

=2 Alignments 7 Information | Parameters Codes |Feature Lines | Surfaces | Boundaries | Slope Patterns
 Feature Lines Code set style:
& Sites : . :
=Default Code Sets need to apply to —
#31 Pipe Networks e _Descripti... Stvle _Label Style Render .. Material ... Pay Item  Classifi
. . . m ) Pressure Networks + Any finish... Pave <none> & Sitework... <none>  <none> ®
CO rrl d O r If yo u Wa nt to See C IVI I 3 D ='W Corridors ‘ E Pavel First pave... Pavel <none> & <none> <none> <none> W%
el i _ = Pave2 Second p... Pave2 <none> <€ <none> <none> <none> W
= u H & Assemblies > ) o E Base Link on th... Base <none> ¢ <none>  <none>  <none> W
CO rrl d O r/CO n Ve rte d COVe ra g e S WI th % Intersections ; B & SubBase Links on s... SubBase  <none> <& Sitework... <none> <none> ¥
# 7 Survey E Formation Bottom fi... Datum <nones & <nones <none> <none>
. " [l View Frame Groups & Kerb Link com... ¢ l"l SubBase ... <none> <none>
m ate rl a I S I n I n fra WO rkS /(% Data Shortcuts [] {8  Verge Sod Area ... Lot <none> & Sitework... <none> <none> ™
¢ Surfaces ' K Footpath Link com... Sidewalk  <none> < Concrete.... <none> <none> &
+ -2 Alignments | k Slope_Link Daylight  <none> < Sitework... <none>  <none>
¥ Pipe Networks : B Ditch Grass Areas <none> ¢a Sitework.... <none> <none> W
% Pressure Networks = B Daylight Daylight li... Daylight  Steep G... €& Sitework.... <none> <none>
O N t . Y I . k h . - Corridors B Daylight_Cut  Cut daylig... Daylight_... <none> < Sitework.... <none> <none> ¥
O e . O u Ca n I n IS raWI n g [ View Frame Groups ST T s e o ' =
directly to InfraWorks or take there

through IMX or LandXML format



Civil 3D Drawing to InfraWorks

Insert in InfraWorks
=Click ‘rg’:k:;r_’
=Click In the Data Sources panel

=Click > %todesk Civil 3D DWG > select the
desired Autodesk Civil 3D drawing, then
click Open

*Note: A local installation of Autodesk Civil
3D 2020 is required before you can import
an Autodesk Civil 3D DWG drawing

DATA SOURCES
Group by: | Feature Type¥ | Show: |All v |
By a| @ &8 X @ = & @
m 3D Model iype Status Date Loaded

(%, ] AutoCAD DWG (3D Objects)

@ AutoCAD DWG as 2D Overlay Imported Wed Jun 26 2019
| Autodesk Civil 3D DWG | Imported Wed Jun 26 2019

(%, ] CityGML
(%,.] DGN 3D Model
(1, ] IFC Indlude All| | Exclude Al

¥ New_Road.dw |
@ LandXML - "_oaﬁiNevg_Road-ROADS

|t‘ | Point Cloud @New_Road - AIW_Existing_Ground

JNew_Road - New_Road_Corridor_Surface
L'TJ Raster @New_Road - CORRIDOR COVERAGES
(%) sDF

(%, ] sHP
(1, ] sQLite
(%, ] Sketchup

I Choose Data Sources X

The Choose Data Sources panels appears and lists which data can be brought in as
InfraWorks model objects. ( InfraWorks will perform a conversion on Autodesk Civil 3D
drawing objects when you bring Autodesk Civil 3D data into InfraWorks.) By default,
the data you bring in from Autodesk Civil 3D is sorted by Feature class, unless you
chose to sort by Source Type in the Data Sources panel.


https://knowledge.autodesk.com/support/infraworks/learn-explore/caas/CloudHelp/cloudhelp/ENU/InfraWorks-UserHelp/files/GUID-B0CE8D89-F17D-422F-8EF9-DA17838F3CE4-htm.html

Civil 3D Drawing to InfraWorks

Configure “Roads”

= |[nfraWorks converts design
road & alignment road both to
a component road and both
will react as a centerline In

InfraWorks

11

InfraWorks

= |f you do not have an design
road but only alignment then
the road will behave as draped

on the surface”

I§] TOOLSPACE

I Choose Data Sources X

¥ New_Road.dwg I
" |@New_Road-ROADS

| |@New_Road - CORRIDOR COVERA

7 Active Drawing View

= New Road

~% Points

-] Point Groups

= Surfaces

'@7 AIW_Existing_Ground

B R New_Road_Corridor_Surface

- Superelevation Views
=X Profiles

v New_Road_PP
~ i Profile Views

- New_Road_Profile
~[® Sample Line Groups
-2 Offset Alignments
< Curb Return Alignments

-~ Rail Alignments

-----

./ Feature Lines
& Sites
- Catchments
#31 Pipe Networks
-3 Pressure Networks
=@ Corridors
é’ New_Road_Corridor
~e2” BL - New_Road_Alignment - (6)
H & Assemblies
% Intersections

1l

HR Survey

‘/OK H Cancel ’

Survey

\

-\
A\
\I

\

\

~"‘. \

— X
DATA SOURCES S X
Group by: | Feature Type¥ | Show: All v |
AvE alk e X @ # a @
Name 4 Source Type Status Date Loaded
v [EJBuildings
[ Building Vector Imported Wed Jun 26 2019
(5 Office_Option_1 3D Model Imported Wed Jun 26 2019
¥ EJCoverage Areas
(5] Site_Boundary Vector Imported Wed Jun 26 2019
v BIGround Imagery
[£118 @ Bing Map Raster Imported Thu Jul 18 2019

¥ [JRoads

Ei'New_Road-ROADS

(5 Site01-Raods - ROADS
¥ [Terrain

(5 Full_Site - SURFACES
(5] Site01 - Surfaces

Civil3DDwg Imported
Autodesk IMX Imported

Autodesk IMX Imported
LandXML Imported

I Data Source Configuration

Fri Jul 19 2019
Wed Jun 26 2019

Tue Jun 25 2019
Wed Jun 26 2019

Name 'New_Road-ROADS | Source | Civil3DDwg |
Description | <Empty= ' Type ‘Roads r \
Common ’ Civi3DDwg = Geo Location =~ Source  Tooltip ~ Table Script
General I Select Component Style X
Hame 'NAME E (J | Component/Assembly v
& o
Q A
External D |EXTE| | £ . < | By
e |9 Generic...Jersey B... L
Description \DESC eneric ... Jersey B...  Lane B ‘
Null  Ramp O...Ramp T...
Elevation -] < A&
Shoulder Sidewalk Sloped ...
Elevation Offset —W‘
mp...
Elevation Offset Frq ‘ -

Sloped ... Two L3 Style Name:

Elevation Offset To

Style Type:

Catalog Name: Component/Assembly

Two Lanes

Component

CIose&RefreshH OK H Cancel \




Civil 3D Drawing to InfraWorks

Configure Corridor in InfraWorks

=Corridor Surface = Terrain
=Corridor = Coverages

TOOLSPACE

[ 4

I Choose Data Sources

Include All | | Exclude Al

Active Drawing View o
[ New_Road g
¢ Points 8
! Point Groups &

- @ Surfaces

/

#6®" AIW_Existing_Ground

H@®" New_Road_Corridor_Surf
7= Alignments

7 Feature Lines

& Sites

B Catchments
+ ¥ Pipe Networks

I Pressure Networks
~ Corridors

+#M” New_Road_Corrido
+ & Assemblies

# Intersections

R Survey
[¥] View Frame Groups
-/[# Data Shortcuts []
@ Surfaces
-8 Alignments

«
»

¥ New_Road.dwg

@INew_Road-ROADS
INew_Road - AIW_Existing_Ground

JNew_Road - New_Road_Corridor_Surfac

INew_Road - CORRIDOR COVERAGES

OK

\ Cancel

DATA SOURCES 5 X
Group by: | Feature Type¥ | Show: All v
v al@ e X @« o @
Name “ Source Type Status Date Loaded
v [EJBuildings
(5 Building Vector Imported Wed Jun 26 2019

[ Office_Option_1 3D Model

¥ [Coverage Areas

E New_Road - CORRIDOR C... Civil3DDwg Configured

Imported Wed Jun 26 2019

¥ Pipe Networks

3 Pressure Networks
B Corridors

I View Frame Groups

[l Site_Boundary Vector Imported Wed Jun 26 2019
¥ BE1Ground Imagery
518 @ Bing Map Raster Imported Thu Jul 18 2019
v [JRoads
[ Site01-Raods - ROADS Autodesk IMX Imported Wed Jun 26 2019
¥ ElTerrain
[5 Full_Site - SURFACES Autodesk IMX Imported Tue Jun 25 2019
\ E New_Road - New_Road_Co... Civil3DDwg  Configured
[5 Site01 - Surfaces LandXML Imported Wed Jun 26 2019
¥ A Hide Details
Data Source Details
Name: <Multiple Values>
Description: <Empty>
Source type: Civil3DDwg

Connection string:  Presentation & Data/000-Final Presentation/04/DataSource/IW04/New_Road.dwg

Coordinate system: TM84-43N (UTM-WGS 1984 datum, Zone 43 North, Meter; Cent. Meridian 75d E)

Date loaded: <Empty>



Civil 3D Drawing to InfraWorks

Let’s Configure “Corridor = Coverages” in InfraWorks

- - - I Autodesk InfraWorks - Mount_Abu_24062019 —
=Civil 3D Corridor gets T
Group by: |Feature Type¥ | Show: |All v |
[
converted in InfraWorks hamEE -

Name “ Source Type Status Date Loaded

v [1Buildings
(5 Building Vector Imported Wed Jun 26 2019
[5 Office_Option_1 3D Model Imported Wed Jun 26 2019

¥ [Coverage Areas
E New_Road - CORRIDOR C... Civil3DDwg
ClSite cto

Coverages if imported

Configured
- Ve Ned Jun 26 20190

[ [ [ v >
directly as Civil 3D . ' B . ame -
. > =4, ' e — _— S P A R S e , 0 , Name  [IDOR COVERAGES| Source |Civil3DDwg |
65600.0 - . u E ; S P = - -
E‘EI — 4 - » = = ~ - o, R : s e : — Description | <Empty> | Type ‘Coverage Areas r ‘
Model Properties® < - p : ’ == - = - i [ i S "- = - - ; -
= ey, PN = : : = . e s DD Common \ Civil3D Dwg Geo Location Source | Tooltp = Table = 4 P
Iq I,.1 00.0 sy N : = = 2 £ =7 —— — = - - = -
. YO u Ca I l C eCk W at St I e S . — 7 — : - — = - = — " General
y w%nf — —  —— — — . Lifespan
] . : - - — _ _, _ - Name | NAME flr |
rule are existed in B
& Style Rules g n Description DESCRIPTION ff)r | Termination Date |<Empty> ()7 |
> —_— e N N
Thumbnail
nfraWorks for coverages g
e Lo : Category ‘<Empty> E‘ﬂ' ‘ Style
Point Cloud Terrain | Rule Style <Empty> % y
» Enabled Name Expression Style(s) - ‘ / ‘
5 Curb-Top  TAG = 'Curb - Top' Material/Roadway/Surface Concrete Linear Pattern
Point Cloud Modeling IS
u; Datum TAG = 'Datum' Material/Colors/Transparent; 1
DR e WS Daylight TAG = 'Daylight' Material/Land Cover/Manicured Grass; 1
w
o Ea @ Daylight_Cut TAG = 'Daylight_Cut'  Material/Land Cover/Manicured Grass; 1 . F
| S tails |
8 - Daylight_Fill TAG = 'Daylight_Fill'  Material/Land Cover/Manicured Grass; 1 b
[
Export Point Cloud Ex. é I
d 1
} e } ‘CIose&RefreshH OK H Cancel | |~
Point Cloud Image Lo. ‘7‘ ‘ Select All ‘ ‘ Deselect All l
v =
Source type: Civil3DDwg |

Connection string:  |Presentation & Data/000-Final Presentation/04/DataSource/IW04/New_Road.dwg |

E ] S| ®

Export Al Import All Commit  Run Rules Coordinate system: TM84-43N (UTM-WGS 1984 datum, Zone 43 North, Meter; Cent. Meridian 75d E)|

Date loaded: | <Empty> \

77 :
2 fi 44 A i
i ey i iy
AT L5777 2508/ 0]47} s 7
i l”l’,’l'.‘,l”' T

$2i[2.5]12%462.962 . N3, '470359:3.4 Zhr‘n{;_ ;:..,.-,_,:»;,{L,’;,;;‘,;‘::;‘..y



Civil 3D Drawing to InfraWorks

Let’s Configure “Corridor Surface = Terrain” in InfraWorks

=Civil 3D Corridor surface gets
converted in terrain surface if
imported directly as Civil 3D drawing

=You can move if from uncategorized
to ground surface or at the desire

level & make sure you switch on the =
layer too | " o s

E New_Road -..
ESite_Boundary @
/@18 @BingMap
¥ [ETerrain Surfaces
& Uncategorized ®
v #Ground Surface®

E( New_Ro...| ‘o
[[site01 ‘g

[ AW Exi... s
ZSite01 1%

\ OK H Cancel ‘ Apply

X: 2725W7-426422}Y: 327577575284 Z:2611-85612{1m

260:270.0




Civil 3D Drawing to InfraWorks

Refresh VS reimport

*Reimport command update the Autodesk Civil 3D
drawing in your InfraWorks model and reflect design

TOOLSPACE

Active Drawing View

modifications. But reimporting the Civil 3D drawing
will give you duplicate roads if the roads have been

./ Feature Lines

& Sites

- Catchments

# 1 Pipe Networks

~J0 Pressure Networks
=Bl Corridors

El-" 84 New_Road_Cort

modified in InfraWorks
=*And by chance you have edited the data already then

as a workaround, you can delete all features of I
selected data source before reimporting it. Else if
feature is not edited you use just re-import Ty
J J °
"Refresh command just reread the data. R F
@) Delete Features 5

=Reimport function is not available if using IMX in Y o

InfraWorks as data source. But if you want then You
can update the IMX file with newer one manually re-
import in InfraWorks.




Question?

/\ AUTODESK.
UNIVERSITY




/\ AUTODESK
Make anytning.

Autodesk and the Autodesk logo are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other brand names, product names, or

trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, and specifications and pricing at any time without notice, and is not responsible for
typographical or graphical errors that may appear in this document.

© 2019 Autodesk. All rights reserved. ‘@ @@@l




